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Préface

Merci d'avoir choisi la gamme de systémes multifonctions noir et blanc ou la gamme de systémes multifonctions
Noir & Couleur TOSHIBA.

Ce manuel explique comment utiliser les fonctions e-Filling de ce systeme.

Lisez ce manuel avant d'utiliser les fonctions du systéme.

Lors d’'une impression avec le toner bleu effacable de la série e-STUDIO5008LP, seuls le papier ordinaire de format
standard et le papier recyclé (64 - 80 g/m2, 17 - 20 lb. Bond) peuvent étre utilisés afin de réutiliser le papier
efficacement. De plus, les fonctions de finition telles que 'agrafage, la perforation ou le pliage central ne peuvent
pas étre exécutées.

B Pour lire ce manuel

O Symboles utilisés dans ce manuel

Dans ce manuel, certains points importants sont signalés au moyen des symboles ci-dessous. Prenez connaissance de
ces points importants avant d'utiliser le systeme.

Indique une situation potentiellement dangereuse qui, si elle n'est pas évitée, peut
/N AVERTISSEMENT  entrainer le décés, des blessures graves, des dommages importants ou l'incendie du
systeme ou de son environnement.
Indique une situation potentiellement dangereuse qui, si elle n'est pas évitée, peut
/\ ATTENTION provoquer des blessures mineures ou légeres, des dégats partiels au niveau du systeme
ou du matériel environnant, ou encore des pertes de données.

- Fournit des informations auxquelles vous devez porter une attention particuliere lors de
Remarque ers s .
['utilisation de ce systeme.

Fournit des informations auxquelles vous devez porter une attention particuliére lors de

Conseil s e \
['utilisation de ce systeme.
0 Pages décrivant des éléments en rapport avec l'action en cours. Consultez-les en

fonction de vos besoins.

O Public cible de ce manuel

Ce manuel est destiné a I'ensemble des utilisateurs et des administrateurs.

O Nom du modeéle et de la série utilisés dans ce manuel

Dans ce manuel, chaque nom de modéle est remplacé par le nom de série présenté ci-dessous.

Nom du modéle Nom de série utilisé dans ce

manuel

e-STUDIO2000AC/2500AC Série e-STUDIO5005AC

e-STUDIO2505AC/3005AC/3505AC/4505AC/5005AC

e-STUDIO2008A/2508A/3008A/3508A/4508A/5008A Série e-STUDIO5008A

e-STUDIO5506AC/6506AC/7506AC Série e-STUDIO7506AC

e-STUDIO5508A/6508A/7508A/8508A Série e-STUDIO8508A

e-STUDIO3508LP/4508LP/5008LP Série e-STUDIO5008LP

O Equipement en option

Pour voir les options disponibles, reportez-vous au Guide de prise en main rapide.

QO Captures d'écran présentées dans ce manuel

¢ Dans ce manuel, le systéme d'exploitation Windows 10 est utilisé a des fins explicatives pour décrire les écrans et
les procédures de fonctionnement sous Windows.
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 Lesinformations des captures d'écran sont susceptibles de varier selon votre modele et 'utilisation du systéme
(par exemple, selon le statut des options installées, la version du systéme d'exploitation et les applications).

* Les écrans d'illustration utilisés dans ce manuel correspondent a un papier de format A/B. Si vous utilisez du papier
de format LT, l'écran ou l'ordre des boutons présenté dans les illustrations peut étre différent de celui de votre
équipement.

O Abréviations utilisées dans ce manuel

Dans ce manuel, les termes "Chargeur de documents avec double numérisation" (DSDF) et "Chargeur retourneur
automatique de documents" (RADF) sont collectivement désignés par "Chargeur automatique de documents" (ADF).

O Marques

Pour plus d'informations concernant les marques, reportez-vous aux Informations de sécurité.
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e-Filing - PRESENTATION GENERALE

Cette section présente les fonctionnalités et fonctions e-Filing.
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Fonctionnalités e-Filing

L’utilitaire e-Filing est installé sur le périphérique de stockage interne du systéme. Il permet de stocker des
documents en vue de les imprimer, de les modifier ou tout simplement de les gérer.
Cette section décrit la fonction de stockage de documents de ['utilitaire e-Filing.

Tableau de bord Ordinateur client

Documents enregistrés
lors d'opérations d'impression
(via le pilote d'impression)

Documents enregistrés lors Documents enregistrés lors

d'opérations de copie/scan

N\,

d'opérations de réception de
fax/fax Internet

[

ﬁ Boite publique
DDossier DEE [% [% gg’
B lagn (e
{ 5 5 B [EEE
—r —v Tous les utilisateurs
Boite utilisateur
[:_—JDossier =| = =
, , 7 15 |5 0 l
ERERERREENE
5 I5 |F Utilisateurs spécifiés
(ou administrateurs)

e Boite publique
La boite publique est un répertoire e-Filing créé par défaut. Tous les utilisateurs ayant accés a cette boite, il
convient d'y stocker des documents partagés dont n'importe quel utilisateur peut avoir besoin. Dans la mesure ou
la boite publique est incorporée au systéme, vous ne pouvez pas la renommer, la supprimer ni en créer une
nouvelle.

* Zone utilisateur
La zone utilisateur est un répertoire e-Filing que chaque utilisateur peut créer. Ce type de zone peut étre protégé
par mot de passe. Il permet a des utilisateurs spécifiques, tels qu'un administrateur, de stocker des documents
confidentiels. Vous pouvez également créer une zone utilisateur sans pour autant la protéger par un mot de passe.
Dans ce cas, cette zone utilisateur sera accessible a tous les utilisateurs au méme titre que la boite publique.
Vous pouvez créer jusqu'a 200 zones utilisateur.

* Dossiers
Vous pouvez créer des dossiers dans chaque boite. Néanmoins, un seul niveau de dossiers peut étre créé dans
chaque boite. Vous ne pouvez donc pas créer de sous-dossiers.
Vous pouvez créer jusqu'a 100 dossiers par boite.

e Documents
Les documents peuvent étre stockés dans une bofte ou un dossier e-Filing par le biais des méthodes suivantes
(Jusqu'a 400 documents peuvent étre stockés dans une boite ou un dossier, et un document peut contenir jusqu'a
200 pages.)
- Copie et enregistrement dans e-Filing
- Numérisation de documents et enregistrement dans e-Filing
- Impression depuis un ordinateur client et enregistrement dans e-Filing
- Les fax/fax Internet requs sont enregistrés dans e-Filing via les fonctions de transfert.
- Les fax/fax Internet regus sont enregistrés dans e-Filing via les fonctions de boftes aux lettres de transfert.
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Remarque

* Pour utiliser les caractéristiques de la fonction Fax, il faut installer l'unité fax.
* Enfonction de la quantité de données stockées dans e-Filing, il peut s'écouler un certain temps entre le moment ou
['équipement est mis sous tension et celui ou e-Filing est prét a étre utilisé.

Conseil

* Pour plus d'informations sur les fonctions de transfert, reportez-vous au Guide de TopAccess.
* Pour plus d'informations sur les fonctions de boTlte aux lettres de transfert, reportez-vous au Guide de la fonction
fax (GD-1370) et au Guide de TopAccess.
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Fonctions e-Filing

P.10 "Fonctions disponibles depuis votre systéeme"
P.11 "Fonctions disponibles depuis un ordinateur client"

B Fonctions disponibles depuis votre systéeme

Vous trouverez ci-apres la liste des fonctions e-Filing que vous pouvez utiliser avec |'écran tactile. Pour plus
d'informations sur leur fonctionnement, reportez-vous aux références données ci-apres.

O Impression de documents

Les fonctions suivantes permettent d'imprimer des documents enregistrés dans e-Filing.

* Pourimprimer tout un document
P.14 "Impression de l'intégralité d'un document"

¢ Pourimprimer quelques pages seulement a des fins de test
P.17 "Test d'impression"

O Stockage de documents

Les fonctions suivantes permettent d'enregistrer des documents dans e-Filing.

* Pour copier et stocker des documents
P.19 "Copier et stocker vers e-Filing"

e Pour numériser et stocker des documents
P.24 "Numérisation vers e-Filing"

O Suppression de documents

Pour supprimer des documents dans e-Filing
P.27 "Suppression de documents"

0 Gestion des zones et des dossiers utilisateur

Les fonctions suivantes permettent de gérer les zones et dossiers utilisateur dans e-Filing. L'écran tactile ne permet
pas de créer ou de modifier des dossiers dans les zones. Pour créer des dossiers, vous devez recourir a un ordinateur
client.

e Pour créer des zones utilisateur
P.29 "Création de zones utilisateur"

* Pour modifier le nom et le mot de passe d'une zone utilisateur
P.30 "Modification des zones utilisateur"

* Poursupprimer des zones et dossiers utilisateur
P.31 "Suppression des zones et des dossiers utilisateur"
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H Fonctions disponibles depuis un ordinateur client n

Vous trouverez ci-apres la liste des fonctions e-Filing que vous pouvez utiliser avec un ordinateur client (utilitaire Web
e-Filing). Pour plus d'informations sur leur fonctionnement, reportez-vous aux références données ci-apres.

Remarque

L'utilitaire Web e-Filing est uniquement compatible avec le systéme d'exploitation Windows. Il ne peut pas étre utilisé
sur les ordinateurs exécutant un autre systeme d'exploitation (Mac OS, etc.).

] Gestion des zones et des dossiers utilisateur

Les fonctions suivantes permettent de gérer les zones et dossiers utilisateur dans e-Filing.

e Pour créer des zones et dossiers utilisateur
P.40 "Création de répertoires et de dossiers utilisateur"

31VY3AN3D NOILYLNISIud - Sunid-o

* Poursupprimer des zones et dossiers utilisateur
P.43 "Suppression de répertoires et de dossiers utilisateur"

* Pour modifier (renommer et changer les propriétés) des zones et dossiers utilisateur
P.44 "Renommer des répertoires et des dossiers utilisateur"
P.46 "Affichage et modification des propriétés des répertoires et des dossiers utilisateur"

O Gestion de documents

Les fonctions suivantes permettent de gérer des documents stockés dans e-Filing.

* Pour afficher des fichiers images sous forme de vignettes ou dans une liste
P.50 "Affichage des documents"

¢ Pourrenommer des documents
P.51 "Renommer des documents"

* Poursupprimer des documents
P.53 "Suppression de documents"

* Pourimprimer des documents (document entier/test d'impression)
P.54 "Impression de documents"

* Pour stocker des documents lors d'une opération d'impression
P.59 "Stockage de documents avec le pilote d'impression”

¢ Pour archiver des documents
P.62 "Archivage de documents"

* Pour envoyer des documents sous forme de messages électroniques
P.66 "Envoi d'un message électronique"

U Modification de documents

Les fonctions suivantes permettent de modifier des documents enregistrés dans e-Filing.

* Pour afficher les propriétés des documents et des pages
P.76 "Affichage des propriétés des documents et des pages"

* Pour copier/couper des pages d'un document et les coller dans un autre
P.77 "Copie de pages d'un document a un autre"

* Pour copier/couper des pages d'un document et les enregistrer dans un nouveau document
P.82 "Copie des pages d'un document dans une boite ou un dossier"

* Pour supprimer des pages d'un document
P.85 "Suppression de pages dans un document"

* Pour insérer des pages vierges dans un document
P.87 "Insertion d'une page vierge dans un document"

* Pour déplacer des pages au sein d'un document afin de modifier ['ordre des pages
P.90 "Déplacement de pages dans un document"

e Pour déplacer des documents d'une zone ou d'un dossier a 'autre
P.93 "Déplacement de documents"

* Pour copier l'intégralité d'un document et l'insérer dans un autre document
P.95 "Fusion de documents"
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¢ Vous pouvez importer des documents e-Filing sur un ordinateur client a l'aide du pilote TWAIN et du Téléchargeur
de fichiers.

* Vous pouvez sauvegarder ou restaurer des documents dans l'e-Filing, ainsi que divers paramétres de ce dernier, a
['aide de |'utilitaire de sauvegarde/restauration e-Filing.
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OPERATIONS REALISEES SUR LE SYSTEME

Cette section décrit les fonctions e-Filing que vous pouvez utiliser a ['aide du tableau de bord du systeme.

IMPression de dOCUMENTS ....ccuiieieerreiiecrentencencrnscascssssascsscssscsscssssascassssscascsssssscssssssssssssssnse 14
Impression de ['intégralité d'Un dOCUMENT......c.cvvieieieiiiee ettt s bbb saseaes 14
TESE A IMPIESSION ...veuvieeieieeiectece ettt et e e teste st ete st e et e besae e sesree s e seessassaesaensasseassessasssesasssassansaansessaessessensenns 17

Stockage de dOCUMENES .. cvuiieiiecireiiriinicrestasiaesrestaessessessasssesssscsessrscasssrsssssasssssssessessrssasssnons 19
Copier et StOCKET VOIS @-FiliNG....cveieiriiriirieieectrtrese sttt sttt ettt ettt et et a et saesbesaassasb e besbensensenessenes 19
NUMEFISALION VOIS €-FIliNE ..cveviviiiieretiiiiiteieeteeie ettt ettt es ettt st et ss st e b b e e e ss st esebeseseasssebebesessssssesasesnasans 24

ANNULAtion de traVauX ..c.cceeiireiieeiieeiireiineiireiireisiseniseieraesrseissasrsesrsescssssrssssssssssssssssssssssnses 26
ANNULATION @ TrAVAUX ©N COUTS ..uiiuiiiiuiriirtiteieteteite e sttt et et b e sr et e e et s e se b b e b et e st emt et sbeebeebenbeeeneen 26
Suppression de travauX d'IMPrESSION .......ciciereeiirieriterirerere et srtesresreetestesaeseesresssessesssessessesseessessesssensessasnes 26

SUPPression de dOCUMENTES ...c.ceieeieieiieriececentecsecsocassessecsssessessecsssassssssssssssssssscsscsssassscsscnsee 2

Gestion des zones et des dossiers UtiliSAteUN ........ccccevieiieieeiieiceiinniancenctanieecsestsscssssoscascsness 29
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Impression de documents

Vous pouvez imprimer des documents stockés dans l'e-Filing grace a 'écran tactile de votre systeme.
P.14 "Impression de l'intégralité d'un document"
P.17 "Test d'impression"

B Impression de l'intégralité d'un document
Vous pouvez imprimer un document dans son intégralité.

1 Dans l'écran d'accueil, appuyez sur [e-Filing].

2 Sélectionnez la boite contenant le document a imprimer.

E-Flllﬂg W Template @ o

Box Number:

001 ] 002 ] o0 Vv o0a ]

UserBox@1 UserBox@2 UserBox@3 UserBox@4

005 ] 006 W 007 W o0 ) 009 W

UserBox@5 UserBox@6 UserBox@7 UserBox08 UserBox@9

Public
Box

Print Box Setting

Job Status

Vous pouvez également spécifier le numéro de boite (3 chiffres).

* Saisie de mot de passe
Si un mot de passe est défini pour la boite sélectionnée, |'écran de saisie du mot de passe apparait. Saisissez le
mot de passe, puis appuyez sur la touche [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir la boite, vous ne pourrez pas vous connecter
pendant une certaine période car cela sera considéré comme un accés non autorisé. Lorsque "La boite est
verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

3 Si le document se trouve dans un dossier, sélectionnez le dossier et appuyez sur la touche [Ouvrir
(Open)].
E-Flllﬂg W Template

001 UserBox@1

B rolceren 10, 09:55

B oocesiers b 10,10:19

A Return

Print Box Setting b
—————
¢ A Job Status 5.

Cette opération est inutile si le document n'est pas stocké dans un dossier.
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Sélectionnez le document. Pour modifier les parameétres d'impression, appuyez sur [Paramétres
(Settings)]. Sinon, appuyez sur [Imprimer (Print)] pour lancer l'impression.

E-Filing W Template

001 UserBox@1 Folder@1

Document Name Date, Time Paper Pages

! DOCB51016 10, 10:15 A4 6

ﬁ Return Settings Test Print (D Print

B oocosiets-eot

10, 10:16

Print ox Setting

Job Status

Sivous appuyez sur [Parameétres (Settings)], passez a |'étape 5.

Si vous appuyez sur [Imprimer (Print)], l'impression démarre. Si vous souhaitez supprimer un travail pour
annuler l'impression, reportez-vous a la section suivante.

P.26 "Annulation de travaux"

Conseil
Appuyez sur pour afficher les images vignettes des documents. Sélectionnez l'image souhaitée et appuyez

sur [Ouvrir (Open)] pour afficher son contenu. Appuyez surE pour revenir a la liste.

e—Filing W Template | @ o

001 UserBox@1

Document / Folder Name

DOC100616-001

A Return Delete Settings |,  TestPrint & Print

Print
————

Job Status
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5 Modifiez les parameétres comme il convient.
Pour les séries e-STUDIO5005AC, e-STUDIO5008A, e-STUDIO7506AC, e-STUDIO8508A

3 4 5
I | NP

na
Settings

Sort

Finishing

None None None

=

ae &0 Time Page
s mageishifi oy Stamp L] Number

>

O Print

1 Side
2-Sided

>

s

8 o Time Page
s NC B

Image Shift | gafy Stamp 2 Number

O, FErasableBlue | |

Cancel @ Print

Vous pouvez paramétrer l'impression comme décrit ci-dessous. Définissez ces derniers comme il convient. Ces
paramétrages sont identiques a ceux effectués en mode de copie. Pour plus d'informations sur la procédure a
suivre, reportez-vous au Guide de copie.

1.

O 00 N O

Sélectionnez le chargeur de papier. Cependant, si le format de papier sélectionné est différent du format de
papier actuellement chargé, la sélection sera annulée et le papier sera sélectionné de fagon automatique.

. Saisissez le nombre de copies a imprimer.
. Sélectionnez le mode d'impression recto verso. Si vous ne voulez pas imprimer sur les deux faces du papier,

sélectionnez [Recto (1 Side)] dans le menu.

. Sélectionnez le mode de finition. Les options de finition disponibles varient en fonction du type de finisseur

installé.

. Sélectionnez le bac de réception. Cette touche est disponible uniquement si le Finisseur (en option) est

installé.

. Définissez la position et la largeur de la marge.

. Définissez la position de la date et de I'heure a imprimer.

. Définissez la position du numéro de page a imprimer.

. Sélectionnez le toner a utiliser pour l'impression. Cette option n'est disponible qu'avec la série

e-STUDIO5008LP.
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6 Appuyez sur [Imprimer (Print)].

Settings

1 Side Sort

. FE! 2-Sided :“ Finishing %l

> > >

None None

e €0 Time Page
ez Silffid “—"ﬁﬁ; Stamp -'!! Num{:er
>

Si vous souhaitez supprimer un travail pour annuler l'impression, reportez-vous a la section suivante.
P.26 "Annulation de travaux"

H Test d'impression
Vous pouvez imprimer certaines pages du document a des fins de test.
1 Dans 'écran d'accueil, appuyez sur [e-Filing].
2 Sélectionnez la boite ou le dossier contenant les documents a imprimer.

e-Filing # Template ® 0

Box Number

oo1 002 003 o004
i~ ¥ i~ i~
o ] L] W L]
Box
UserBox@1 UserBox02 UserBox@3 UserBox@4

L5 T’ 006 F’ o7 T’ oo F’ 009 F’

UserBox@5 UserBox@6 UserBox@7 UserBox@8 UserBox@9

Print

Job Status

L'étape concernant la sélection de boite/dossier a été volontairement omise dans la mesure ol cette étape est
identique a celle décrite dans la procédure Impression de l'intégralité d'un document.
P.14 "Impression de l'intégralité d'un document"

3 Sélectionnez le document a imprimer, puis appuyez sur [Test d'impr. (Test print)].

e—Filing W Template

001 UserBox@1

Document / Folder Name Date, Time Paper Pages

B Folderon

P oocosios 10,10:19

! DOCB51016-001 10,12:34

A Return Delete Settings Test Print
Print

JobStatus 5

Sivous possédez la série e-STUDIO5005AC, e-STUDIO5008A, e-STUDIO7506AC ou e-STUDIO8508A, passez a
['étape 5.

Conseil
Appuyez sur pour afficher les images vignettes des documents. Sélectionnez l'image souhaitée et appuyez

sur [Ouvrir (Open)] pour afficher son contenu. Appuyez surE pour revenir a la liste.
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4 Sélectionnez cette option pour spécifier le toner a utiliser pour 'impression.

W Template

Test Print

Enter th
First Page 1
Last Page 1

AllL Pages

S ErasableBlue | |/

¢ [Bleu effacable (Erasable Blue)] : les originaux sont imprimés avec toner de bleu effacable.

¢ [Noir (Black)] : les originaux sont imprimés en noir et blanc.

Conseil

Cette option n'est disponible qu'avec la série e-STUDIO5008LP.

5 Indiquez les numéros de page appropriés dans [Premiére page (First Page)] et [Derniére page
(Last Page)], puis sur [Imprimer (Print)].

Test Print

First Page

* Sivous appuyez sur la touche [Effac. (Clear)] du tableau de bord, la valeur saisie dans le champ actuellement
sélectionné peut étre supprimée.
* Pourimprimer toutes les pages du document, appuyez sur [Toutes les pages (All Pages)].

Sivous souhaitez supprimer un travail pour annuler l'impression, reportez-vous a la section suivante.
P.26 "Annulation de travaux"
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Stockage de documents

Vous pouvez stocker des documents dans 'e-Filing grace a |'écran tactile de ce systeme.
P.19 "Copier et stocker vers e-Filing"
P.24 "Numérisation vers e-Filing"

Remarque

* Stockez vos documents confidentiels dans une zone utilisateur protégée par un mot de passe.

* Jusqu'a 400 documents peuvent étre stockés dans une boite ou un dossier, et un document peut contenir jusqu'a
200 pages.

* La capacité maximale disponible dans le dossier partagé differe selon le modéle ou environnement d'exploitation
que vous utilisez. Vous pouvez vérifier |'espace total disponible dans le dossier partagé et dans e-Filing dans
l'onglet [Périphérique (Device)] de TopAccess.

* Lesystéme e-Filing n'a pas été concu pour stocker des documents de facon permanente. Supprimez les documents
des qu'ils sont obsoletes.

P.27 "Suppression de documents"

* Les formats des originaux suivants n'étant pas correctement détectés, vous devez les sélectionner manuellement

lorsque vous les placez:

- Originaux trés transparents (transparents ou papier calque, par exemple)
- Originaux entierement sombres ou comportant des bords sombres
- Originaux de format non standard (journaux, magazines, etc.)

Pour plus d'informations, reportez-vous au Guide de la préparation du papier.

Conseil

* Pour stocker des documents dans des zones utilisateur et des dossiers, vous devez créer ces derniers a |'avance.
P.29 "Création de zones utilisateur" (Utilisation sur ce systéme)
P.40 "Création de répertoires et de dossiers utilisateur" (Utilisation sur un ordinateur client)

* Vous pouvez définir la durée de stockage des documents dans la fenétre des propriétés des zones utilisateur. Les
documents seront supprimés une fois cette période dépassée.
P.46 "Affichage et modification des propriétés des répertoires et des dossiers utilisateur" (Utilisation sur un
ordinateur client)

M Copier et stocker vers e-Filing

Vous pouvez copier et stocker des documents dans e-Filing. Les documents e-Filing peuvent étre copiés et stockés
simultanément.

Remarque

* Les documents dont les formats de papier sont affichés ci-dessous ne peuvent pas étre stockés dans e-Filing.

- Papier personnalisé
- Format papier non standard (bac de dérivation)

* Les documents archivés par copie vers e-Filing pourront étre imprimés. En revanche, ils ne pourront pas étre
importés sous forme d'image sur un ordinateur client. L'importation avec une qualité d'image optimale nécessite
un archivage par numérisation vers e-Filing.

P.24 "Numérisation vers e-Filing"

Mettez les originaux en place et définissez le mode de copie.
Pour plus d'informations sur la mise en place des originaux et le paramétrage du mode de copie, reportez-vous
au Guide de la préparation du papier | Guide de Copie.

Remarque

Sivous choisissez le mode "Twincolor Copy (Copie 2)" ou "Monochrome (Monochrome)" dans 'onglet [Image],
vous ne pouvez pas stocker les documents dans le systeme e-Filing. Ces modes ne permettent pas non plus de
stocker des documents tout en les copiant.
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2 Appuyez sur [Stockage (Storage)] dans l'écran de copie.

Copy Storage Settings |, o Template ﬂ @ o
Ready

Non-Sort
Non-Staple

g Finishing

11
Simplex

i Original
?g.i 2-Sided s
>

Text/Photo

'@ Stop
Edit Image

JobStatus 5

Copy Storage Settings |, o Template ﬂ @

Ready et

re To e-Filing Copy & File

& Box / Folder

DOCB51016

Cancel

JobStatus 5

Copy Storage Settings , r Template | ﬂ @ o
Ready ‘

Store To e-Filing Copy & File

ient Name [DOCO51916

Job Status
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5 Sélectionnez le répertoire ol vous souhaitez stocker les données.

e-Filing

Box Number

Public
Box

o0s ]

UserBox@5

Vous pouvez également spécifier le numéro de boite (3 chiffres).

001 i"

UserBox@1

msi_'

UserBox@6

002 i"

UserBox@2

007 T

UserBox@7

¢ Saisie de mot de passe
Siun mot de passe est défini pour la boite sélectionnée, |'écran de saisie du mot de passe apparait. Saisissez le
mot de passe, puis appuyez sur la touche [OK].

Remarque

W Template @ o

[ t’ 004 T’

UserBox@3 UserBox@4

m" mfr

UserBox08 UserBox@9

Job Status

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir la bolte, vous ne pourrez pas vous connecter
pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite est
verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

6 Pour stocker les documents dans le répertoire sélectionné, appuyez sur [OK].

e-Filing

001 UserBox01

Document / Folder Name

B o

P oocesies

* Stockage dans un dossier

W Template | @ o

Paper Pages

Job Status

Sélectionnez le dossier et appuyez sur [Ouvrir (Open)] pour en afficher le contenu. Pour stocker les documents
dans le dossier sélectionné, appuyez sur [OK].

e-Filing

001 UserBox@1

Document / Folder Name

B Folceron

P [u)cuswmb

W Template

Date, Time
10, 09:55

10, 10:19

Job Status

>
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7 Modifiez le nom du document, puis appuyez sur [OK].

Copy Storage Settings W Template ﬂ @
Ready ‘ Set

1
Store To e-Filing Copy &File
Box / Folder . Box No. 001
Box Name |UserBox@1
Folder Name
Document Name |DOCE51016

Cancel

Job Status

* Renommer des documents
Saisissez le nom du document (64 caractéres maximum) dans [Nom document (Document name)] et appuyez
sur [OK].

Conseil

* Une chaine de caractéres composée de "DOC", année, mois et date s'affiche par défaut. Ce format peut étre
modifié dans Top Access. Pour plus d'informations, reportez-vous au Guide de TopAccess.

* Siunnom identique a déja été enregistré, un numéro de série (-001, -002...) sera ajouté automatiquement a la
fin du nom du fichier et enregistré.

8 Appuyez sur [Oui (Yes)] pour stocker et imprimer le document. Pour stocker le document sans
l'imprimer, appuyez sur la touche [Non (No)].

S Settings , o Template P4 @ 0

Storage

Confirmation

Print this document?

Cancel

JobStatus 5

9 Appuyez sur la touche [DEMARRER (START)].
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Copie de l'original suivant (copie)

En fonction de la facon dont ['original est chargé, 'écran vous invitant a confirmer la copie de 'original suivant
peut s'afficher. Répétez la procédure ci-dessous autant de fois que nécessaire. Une fois la numérisation de la
derniére page de l'original terminée, appuyez sur [Job fini (Job Finish)].

* Si les originaux sont copiés via la vitre, placez 'original suivant puis appuyez sur [Copie suivante (Next copy)]
pour commencer la numérisation.

* Lorsque l'original est placé dans I'ADF en mode d'alimentation simple, la numérisation ne commence que
lorsque l'original suivant est chargé. Aucune intervention de ['utilisateur n'est nécessaire.

Scan Page

Next
Copy

Job Cancel Job Finish @
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B Numérisation vers e-Filing

Vous pouvez numériser et stocker des documents dans e-Filing. Lorsque vous importez un original sous la forme
d'une image sur un ordinateur client, il est conseillé de stocker le document a l'aide de la fonction de numérisation
vers e-Filing.

Pour utiliser cette fonctionnalité, la fonction de numérisation est requise.

1 Placez l'original du document a enregistrer puis paramétrer le mode Scan si nécessaire.
Pour plus d'informations sur la mise en place des originaux et le paramétrage du mode de scan, reportez-vous au
Guide de la préparation du papier / Guide du Scan.

2 Appuyez sur [e-Filing].

Scan Settings | Template {l}'_ @ o

Select Menu!!

!> E-mail i File
>
%“ ¥ wssean i e a
> >

Scan Setting

Destination File Name File Format 2 Preview

Job Status

3 Sélectionnez le répertoire ou le dossier ou vous souhaitez stocker les documents. Modifiez le nom
du document, puis appuyez sur [OK].

Scan Settings  f Template ﬁl‘r'_ @ 0

Select Menu!!

Box / Folder .

Box No. 001
Box Name | User!

Folder Name |Falder@1

Document Name DOCB51016

Cancel

Job Status

L'étape concernant la sélection de répertoire/dossier et le changement du nom d'un document a été
volontairement omise dans la mesure ou cette étape est identique a celle décrite dans la procédure Copier et
stocker vers e-Filing.

P.19 "Copier et stocker vers e-Filing"
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4 Appuyez sur [Scan].

Scan Settings , W Template ﬁh @ 0
Select Menu!!
Press SCAN to start scanning.

% )
@ e-Filing
> b -

>

Scan Setting

Destination File Name File Format B Preview
UserBox01 DOCO51016

Remarque

Le nombre acceptable de travaux de scan réservés varie selon les parametres. Si les travaux réservés dépassent
le nombre correspondant, un message vous informant que le nombre maximum de réservations a été dépassé
apparait Dans ce cas, attendez que les travaux de numérisation réservés aient été traités ou supprimez ceux qui
sont inutiles.

P.26 "Suppression de travaux d'impression”

Numérisation de 'original suivant (scan)

* Lorsque l'original est placé sur la vitre ou que vous appuyez sur la touche [Continuer (Continue)] lors de la
numérisation d'originaux placés dans le chargeur automatique de documents, |'écran vous invitant a
confirmer la numérisation de ['original suivant apparait.

* Dans ce cas, placez le nouvel original et appuyez sur [Scan] pour le numériser. Suivez cette procédure autant
de fois que nécessaire. Lorsque tous les originaux sont numérisés, appuyez sur [Job fini (Job Finish)].

Scanning

To continue, Plac

Scan Page Original Size

Ad

Job Cancel Scan Setting o Job Finish

* Vous pouvez modifier les paramétres de scan en appuyant sur [Param. de num. (Scan Setting)].
* Vous pouvez annuler la réservation des données numérisées en appuyant sur [Annul job (Job Cancel)].
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Annulation de travaux

P.26 "Annulation de travaux en cours"
P.26 "Suppression de travaux d'impression”

B Annulation de travaux en cours

Si vous souhaitez annuler l'impression ou la numérisation en cours d'un document, appuyez sur [Stop].

H Suppression de travaux d'impression

Suivez la procédure décrite ci-apres pour arréter l'impression ou la numérisation d'un document (suppression d'un
travail d'impression).

Appuyez sur [Etat trav. (Job Status)].
Dans le menu relatif a 'état des travaux, affichez la liste des travaux.

Sélectionnez le travail a supprimer, puis appuyez sur [Supprimer (Delete)].

W =

L'écran de confirmation de la suppression apparait. Appuyez sur la touche [Supprimer (Delete)].
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Suppression de documents

Vous pouvez supprimer des documents dans e-Filing en utilisant 'écran tactile de ce systeme.

Remarque

Le systéme e-Filing n'est pas congu pour sauvegarder des documents indéfiniment. Supprimez les documents dés
qu'ils sont obsolétes.

Conseil

La suppression d'un dossier ou d'un répertoire entraine systématiquement la suppression des documents qu'ils
contiennent.

P.31 "Suppression des zones et des dossiers utilisateur" (Utilisation sur ce systeme)

P.43 "Suppression de répertoires et de dossiers utilisateur" (Utilisation sur un ordinateur client)

1
2

Dans 'écran d'accueil, appuyez sur [e-Filing].

Sélectionnez la boite ou le dossier contenant le document a supprimer.

E-Fll.ll"lg W Template @ 0

Box Number:

001 T 002 Vv 003 ] o0a ]

UserBox@1 UserBox@2 UserBox@3 UserBox@4

005 ] 006 ) 007 5 008 W 009 W

UserBox@5 UserBox06 UserBox07 UserBox@8 UserBox@9

Print Box Setting

Job Status

L'étape concernant la sélection de répertoire/dossier a été volontairement omise dans la mesure oU cette étape
est identique a celle décrite dans la procédure Impression de l'intégralité d'un document.
P.14 "Impression de 'intégralité d'un document"

Sélectionnez le document a supprimer, puis appuyez sur [Supprimer (Delete)].

e—Filing W Template

001 UserBox@1

Document / Folder Name Date, Time Paper Pages
Folder@1
§ DOC051016

§ DOCO51016-001 10, 12:34

Return Settings Test Print - <D Print

Print Box Setting

JobStatus

Conseil
Appuyez sur pour afficher les images vignettes des documents. Sélectionnez l'image souhaitée et appuyez

sur [Ouvrir (Open)] pour afficher son contenu. Appuyez surE pour revenir a la liste.
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4 Appuyez sur [Supprimer (Delete)] pour supprimer le document sélectionné.

e—Filing W Template

Attention
001 UserBoxc

B Foldero

DOCOS51(

DOCO51

o>

Print Box Setting

JobStatus

Vous pouvez annuler la suppression du document sélectionné en appuyant sur la touche [Annuler (Cancel)].
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Gestion des zones et des dossiers utilisateur

Vous pouvez gérer les zones et dossiers utilisateur de l'e-Filing a l'aide de ['écran tactile de ce systeme.
P.29 "Création de zones utilisateur"

P.30 "Modification des zones utilisateur"

P.31 "Suppression des zones et des dossiers utilisateur"”

Conseil

Les dossiers peuvent étre créés et modifiés par le biais d'un ordinateur client.

P.40 "Création de répertoires et de dossiers utilisateur"

P.44 "Renommer des répertoires et des dossiers utilisateur"

P.46 "Affichage et modification des propriétés des répertoires et des dossiers utilisateur"

B Création de zones utilisateur
Vous pouvez créer jusqu'a 200 zones utilisateur.

Dans l'écran d'accueil, appuyez sur [e-Filing].
1

2 Appuyez sur l'onglet [Param. répert. (Box Setting)], sélectionnez une touche vierge numérotée
de "001" a ""200", puis appuyez sur [Config. (Setup)].

e-Filing

Box Number

010 T’

UserBox10

015 T’

Print

JobStatus

De plus, vous pouvez directement spécifier le numéro de boite (3 chiffres).

3 Entrez le nom de la boite et le mot de passe dans les champs [Nom boite (Box name)], [Mot de
passe (Password)] et [Retaper mdp (Retype password)], puis appuyez sur [OK].

Password

Retype Password

* Saisie du nom de la boite
Saisissez le nom de la boite (32 caractéres maximum) dans [NOM BOITE (BOX NAME)] et appuyez sur [OK]. Les
caracteres ci-dessous, codés sur un seul octet, ne peuvent pas étre utilisés.
"H%&' =[{} <>2[];:/\,
N'insérez ni espace ni point au début ou a la fin du nom. Si vous saisissez |'un de ces caracteres, un message
vous informant que le caractére utilisé n'est pas correct apparait.

¢ Saisie d'un mot de passe
Vous pouvez créer une zone utilisateur sans définir de mot de passe. Si vous appuyez sur [OK] sans saisir de
mot de passe, vous créez une zone utilisateur et une boite publique auxquelles tous les utilisateurs peuvent
accéder.
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Remarque

Si le mot de passe saisi ne respecte pas la police de mot de passe, un message d'avertissement apparait.
Saisissez le mot de passe correct.
Pour plus d'informations sur la police de mot de passe, reportez-vous au Guide de TopAccess.

B Modification des zones utilisateur
Vous pouvez modifier le nom et le mot de passe d'une zone utilisateur.

1 Dans 'écran d'accueil, appuyez sur [e-Filing].

9 Appuyezsur l'onglet [Param. répert. (Box Setting)], sélectionnez le répertoire utilisateur a
modifier, puis appuyez sur [Modifier (Edit)].

e-FIl.II"Ig W Template @ 0

Box Number:

o010 '.? o1 i.,’ 012 ‘,' 013 ‘,’ 014 i.a

UserBox 10 UserBox11

015 i.’ 016 b 017 F’ 018 T’ 019 i.’

Delete
Print

Job Status

De plus, vous pouvez directement spécifier le numéro de boite (3 chiffres).

* Saisie de mot de passe
Si un mot de passe est défini pour la boite sélectionnée, |'écran de saisie du mot de passe apparait. Saisissez le
mot de passe, puis appuyez sur la touche [OK].

Conseil

Le mot de passe de l'administrateur peut également étre utilisé ici.

Changez les champs [Nom boite (Box name)] / [MDP (Password)] / [Retaper mdp (Retype
password)] si nécessaire, puis appuyez sur [OK].

Box Modify

me UserBox11

ord #000000

Cancel

L'étape concernant le paramétrage des champs [Nom répert. (Box Name)] / [Mot de passe (Password)] /
[Ressaisir MDP (Retype Password)] a été volontairement omise dans la mesure ou cette étape est identique a
celle décrite dans la procédure Création de répertoires utilisateur.

P.29 "Création de zones utilisateur"
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l Suppression des zones et des dossiers utilisateur
Vous pouvez supprimer des zones et des dossiers utilisateur.

Remarque

La suppression d'un dossier ou d'une zone entraine systématiquement la suppression des dossiers et documents
qu'ils contiennent.
1 Dans 'écran d'accueil, appuyez sur [e-Filing].

2 Suivez la procédure décrite ci-apres pour supprimer des dossiers et des zones utilisateur.

¢ Suppression de zones utilisateur
Appuyez sur 'onglet [Param. répert. (Box Setting)], sélectionnez le répertoire utilisateur a supprimer, puis
appuyez sur [Supprimer (Delete)].

W Template @ 0

o010 i.’ o1 i.’ 012 f’

UserBox 10 UserBox11

o ]

»
Print ' Box Setting '
!1 os/m0rt JobStatus

L'étape concernant la sélection de zones utilisateur a été volontairement omise dans la mesure ou cette étape
estidentique a celle décrite dans la procédure Modification des zones utilisateur.
P.30 "Modification des zones utilisateur"

¢ Suppression de dossiers
Affichez 'onglet [Imprimer (Print)], sélectionnez le dossier a supprimer, puis appuyez sur [Supprimer (Delete)].

e—Filing W Template |

011 UserBox11

Document / Folder Name Date,Time Pages

B Folderon 10, 13:07

P oocesiors

Delete

Print Box Setting
—— () S—
y ) ¢ Job Status 5

L'étape concernant la sélection de dossiers a été volontairement omise dans la mesure ol cette étape est
identique a celle décrite dans la procédure Impression de l'intégralité d'un document.
P.14 "Impression de l'intégralité d'un document"
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3 Appuyez sur [Supprimer (Delete)] pour supprimer le document/la boite sélectionné(e).

e—Filing W Template @ 0

Attention

Box Number:

o010 F

UserBox10

015 "

Delete

Print

JobStatus

Vous pouvez annuler la suppression du répertoire/du dossier sélectionné en appuyant sur la touche [Annuler
(Cancel)].
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UTILISATION SUR UN ORDINATEUR CLIENT

Cette section explique le fonctionnement de ['utilitaire Web e-Filing a partir d'un ordinateur client.

Avant d'utiliser l'utilitaire Web e-Filing .....cccccceeiveiirniiniiniinniiiaesiesinnicissiaiissicsssissscssscsnees 34
NaVigateurs Web Pris €N CRArZe.. ..ottt sttt ettt et et eae b b e benteneen 34
Procédure de paramétrage de MiCroSOft EAQE.......cceeeiiririereeiririeietesiisie e sesesss e se e ss s ssesesasasssesesasas 34

Mise en route a partir de l'utilitaire Web e-Filing ......ccccceeeererierrererrrererrrrsssrssrsrssssssssssssssssnnnes 36
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Création de répertoires et de doSSIers ULIlISATEUN..........ciieeierererieeieeerereeeeee ettt e es st 40
Suppression de répertoires et de doSSIers UtIlISATEUN ......c.c.cueuivieieierereeee ettt e ve e 43
Renommer des répertoires et des doSSIiers UtIlISATEUN ..........cceieeeierereeieeereeeee ettt esanes 44
Affichage et modification des propriétés des répertoires et des dossiers utilisateur.......c.coceeeeeeeeenernnns 46
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Avant d'utiliser ['utilitaire Web e-Filing

Avant d'utiliser |'utilitaire Web e-Filing, vérifiez les éléments suivants sur votre ordinateur.
P.34 "Navigateurs Web pris en charge"
P.34 "Procédure de paramétrage de Microsoft Edge"

Remarque

L'utilitaire Web e-Filing est uniquement disponible pour les ordinateurs disposant du systeme d'exploitation
Windows. Vous ne pouvez pas ['utiliser sur un ordinateur fonctionnant sous Mac OS ou sous un autre systéme
d'exploitation.

H Navigateurs Web pris en charge
L'utilitaire Web e-Filing fonctionne avec les navigateurs des systémes d'exploitation Microsoft Windows suivants :

* Microsoft Edge

* Internet Explorer 9.0 ou version ultérieure

* Firefox 38 ou version ultérieure

e Chrome 45 ou supérieur

* La résolution d'écran minimale requise pour ces navigateurs est de 800 x 600.

 Désactivez la fonction de blocage des fenétres contextuelles du navigateur Web. Pour plus d'informations sur le
paramétrage de la fonction de blocage des fenétres contextuelles, reportez-vous a la rubrique d'aide du navigateur
Web utilisé.

* Lorsde ['utilisation de Microsoft Edge, désactivez le paramétre [Bloquer les fenétres pop-ups (Block pop-ups)] en
cliquant sur [OFF]. Sélectionnez également le paramétre [Ne pas bloquer les cookies (Don't block cookies)]. Pour
des instructions sur le paramétrage de Microsoft Edge, reportez-vous a la procédure ci-apres.

P.34 "Procédure de paramétrage de Microsoft Edge"

 Dans Internet Explorer, I'option Confidentialité doit étre paramétrée sur Moyenne. Ne sélectionnez ni la valeur

"Haute", ni la valeur "Bloquer tous les cookies".

M Procédure de paramétrage de Microsoft Edge
Lorsque vous utilisez Microsoft Edge, veillez a effectuer le paramétrage indiqué ci-apres.

1 Sélectionnez --- (Plus d'actions) > [Parameétres (Settings)] > [Afficher les parameétres avancés
(View advanced settings)].

B =g X |+ = @O
&« > D | mm | =@ O

SETTINGS e 1

2

Reading view style

. Reading
Logs Registratior

Device | Defaut ~ |
Device Information Reading view font size
Status
Name | Medium ~ |
Location
Copier Model
Serial Number Advanced settings
MAC Address
Main Memory Size

| View advanced settings |

Page Memory Size
Save as File & e-Filing St
Fax Space Available

e About this app
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2 Désactivez le parameétre [Bloquer les fenétres pop-ups (Block pop-ups)] en cliquant sur [OFF].

B = g e ®x |+
< > 0 | mw
- Job Status Logs Regisiratior
Device
Device Information

Status
Hame
Location
Copier Model
Serial Mumber
MAC Address
Save as File & e-Filing S
Fax Space Available

@

X

O
= £

¥ |

« Advanced settings

Show the home button
@ off

Block pop-ups

@ o

Use Adobe Flash Player
@ on

Always use caret browsing

@ o

3

Sélectionnez également [Ne pas bloquer les cookies (Don't block cookies)] pour le paramétre

[Cookies].
B =g X |+ = O X
€ > 0 | mm x| =20
« Advanced settings -2
[ oy gy A
Device Job Status Logs Registratior )
Show search suggestions as | type
. @D o
Device
i rCookies
Device
| Don't block cookies 4
g
Location
Copier Model Let sites save protected media L%ences onmy
Serial Mumber device
MAC Address
Save as File & e-Filing 5 Q On
Fax Space Available

4 Quittez Microsoft Edge et relancez-le avant d'accéder a l'e-Filing.

Remarque

Quittez Microsoft Edge une fois |'utilitaire Web e-Filing ouvert. Pour vous déconnecter de ['utilitaire Web e-Filing
en mode utilisateur, cliquez sur le lien Déconnexion et quittez Microsoft Edge.
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Mise en route a partir de l'utilitaire Web e-Filing

Cette section explique comment démarrer et quitter ['utilitaire Web e-Filing. La procédure de lancement de ['utilitaire
varie selon que vous étes connecté en tant qu'utilisateur ou administrateur systéme.

P.36 "Connexion en tant qu'utilisateur”
P.100 "Connexion en tant qu'administrateur systéme"

l Connexion en tant qu'utilisateur
Il existe deux fagons d'accéder a l'utilitaire Web e-Filing :

e Cliquez surle lien de l'utilitaire Web e-Filing du site Web TopAccess.
* Saisissez I'URL de 'utilitaire Web e-Filing dans le champ d'adresse de votre navigateur Web.

L'URL de l'utilitaire Web e-Filing est : http://[adresse IP]/?MAIN=EFILING

La partie [adresse IP (IP address)] correspond a l'adresse IP de ce systéme. Vous pouvez également utiliser le nom DNS
de ce systeme.

Par exemple, l'adresse IP du systéeme est 192.168.1.2

http://192.168.1.2/?MAIN=EFILING

Par exemple, le nom DNS du systéeme est mfp-00000236.

http://mfp-00000236/?MAIN=EFILING

A propos du paramétre de gestion des utilisateurs

Si la fonction de gestion des utilisateurs est activée, la page de connexion s'affiche lorsque vous accédez a 'URL
de l'utilitaire Web e-Filing. Dans ce cas, veuillez saisir vos identifiants d'authentification (nom d'utilisateur et mot
de passe) pour accéder a la page principale de 'utilitaire Web e-Filing.

Login with your . User Name and Password.

User Name | |

Password | |

Remarque

Si vous entrez plusieurs fois un mot de passe d'authentification incorrect pour vous connecter au systeme
multifonctions TOSHIBA, vous ne pourrez pas vous connecter pendant un certain temps car cela sera considéré
comme un acces non autorisé.

Conseil

* Les utilisateurs peuvent lancer 'utilitaire Web e-Filing pour utiliser ses fonctions.

* L'acces a l'utilitaire Web e-Filing expire au terme du délai défini pour la minuterie de session dans les parametres
Web généraux sous TopAccess.

* Pour utiliser les fonctions d'administrateur de ['utilitaire Web e-Filing, |'utilisateur doit se connecter en tant
qu'administrateur systeme.
P.100 "Connexion en tant qu'administrateur systeme"
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Menus de l'utilitaire Web e-Filing

L'interface de ['utilitaire Web e-Filing comprend trois onglets situés dans la partie supérieure droite du navigateur
Web : l'onglet [Documents], l'onglet [Préférences (Preferences)] et |'onglet [Administration].

Documents Preferences Administration ngolll

Ils permettent d'afficher et de manipuler vos documents, de définir des préférences d'affichage et d'exécuter des
fonctions d'administration.

P.37 "Onglet [Documents]"

P.39 "Onglet [Préférences (Preferences)]"

A droite des onglets principaux se trouve le lien Connexion permettant de se connecter en tant qu'administrateur
systéme.

P.39 "Lien Connexion"

l Onglet [Documents]

L'onglet [Documents], qui apparait par défaut, est accessible par tous les utilisateurs. Il se compose d'un volet
Dossiers et documents, d'une barre de menus et d'un volet Contenu.

2 3
| |
" Electronic Filing Login
i

File
Document {8 e-Filing (8 items)
4{Ea e-Filing
1 - [ Public Box

&l 001 UserBox01
5f) 002 UserBox02 Ea ﬁa ,:a r:a

& 003 UserBox03 ] 5] & _Aa
&F1 004 UserBox04
&) 005 UserBox05
&) 006 UserBox06
§f) 007 UserBox07 Cpublic Box CJoo1 userBoxo1 [J002 userBox02 [Jo03 userBox03

& Bl Bl Bl

[Jo04 userox04 [Joos userBoxo0s [Joo6 userBoxa6 [oo7 userBoxa7

Top | Help

1. Volet Document
Le volet document s'affiche comme interface utilisateur de type Explorateur. Ce volet vous permet de
sélectionner les dossiers et documents cibles.
Dans le volet Document, les icdnes suivantes s'affichent en fonction des éléments.

- lcbnes des répertoires
Ea : Cette icone indique que le répertoire est fermé.
&ﬂ : Cette icbne indique que le répertoire est ouvert.
Eﬂ : Cette icdne indique que le répertoire fermé est protégé par un mot de passe.

% : Cette icone indique que le répertoire ouvert est protégé par un mot de passe.
- lIcones des dossiers

D : Cette icone indique que le dossier est fermé.

E : Cette icone indique que le dossier est ouvert.
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- lcones des documents

@ : Cette icone désigne un document archivé par le biais d'une impression. Lorsqu'elle s'affiche avec un
fond de couleur blanche, le document est en cours de consultation. Lorsqu'elle s'affiche avec un fond de
couleur bleue, le document est en cours de modification.

E |_IEI : Cette icone désigne un document archivé par le biais d'une numérisation. Lorsqu'elle s'affiche avec
un fond de couleur blanche, le document est en cours de consultation. Lorsqu'elle s'affiche avec un fond de
couleur bleue, le document est en cours de modification.

E : Cette icone désigne un document archivé par le biais d'une copie. Lorsqu'elle s'affiche avec un fond
de couleur blanche, le document est en cours de consultation. Lorsqu'elle s'affiche avec un fond de couleur
bleue, le document est en cours de modification.

Eﬂ : Cette icone désigne un document archivé lors d'une opération de fax par le biais de la fonction de
boite aux lettres, de transfert de fax recus ou de transfert de fax Internet recus.

Lorsqu'elle s'affiche avec un fond de couleur blanche, le document est en cours de consultation. Lorsqu'elle
s'affiche avec un fond de couleur bleue, le document est en cours de modification.

Cette icOne désigne un document obtenu par fusion de plusieurs documents. Lorsqu'elle s'affiche
avec un fond de couleur blanche, le document est en cours de consultation. Lorsqu'elle s'affiche avec un fond
de couleur bleue, le document est en cours de modification.

2. Barrede menus
Vous pouvez activer la fonction e-Filing depuis la barre de menus. Elle contient les menus Fichier, Modifier,
Visualiser et Mise en page.

3. Barred'outils
La barre d'outils contient les icones relatives aux fonctions suivantes : Envoyer un e-mail, Enregistrer, Test
d'impression, Couper, Copier, Coller, Début, Précédent, Suivant et Fin. Elles vous offrent un accés rapide aux
fonctions cibles.

@ : Cliquez sur cette icone pour envoyer les documents sélectionnés par message électronique.

—
: Cliquez sur cette icbne pour enregistrer le document. Elle n'est active que lorsque le document est cours de
modification.

% : Cliquez sur cette icone pour effectuer un test d'impression.
: Cliquez sur cette icone pour couper les pages ou documents sélectionnés.

: Cliquez sur cette icone pour copier les pages ou les documents sélectionnés.

=1 : Cliquez sur cette icdne pour coller les éléments copiés.
: Cliquez sur cette icone pour afficher les premiers éléments du volet Contenu.
: Cliquez sur cette icone pour afficher les précédents éléments du volet Contenu.

: Cliquez sur cette icone pour afficher les éléments suivant immédiatement ceux affichés dans le volet
Contenu.

: Cliquez sur cette icone pour afficher les derniers éléments du volet Contenu.

4. Volet Contenu
Le volet Contenu affiche les documents ou pages en cours de traitement. Il vous permet de modifier ['état du
document puis de l'imprimer et de |'éditer. Pendant que vous travaillez sur votre document, son état et les
touches de controle correspondantes s'affichent.

Conseil

Pour plus d'informations sur ces boutons, reportez-vous a la section suivante :
P.75 "Edition des pages de vos documents"
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Bl Onglet [Préférences (Preferences)]

L'onglet [Préférences (Preferences)] est accessible par tous les utilisateurs. Il permet de définir le mode d'affichage du

document et le nombre de vignettes a l'écran.

(' Electronic Filing

Preferences

1 = Default Document Viev: | Thumbnail view -
2 = Load thumbnails per view.

3 —_] Display the progress bar.

Login

4 —we [Resal]
N

Top | Help

1. Affichage par défaut du document

Vous pouvez choisir le mode d'affichage Vignettes ou Liste, qui est conservé jusqu'a ce que vous sélectionniez

une autre option dans le menu Affichage. Le mode Vignettes est défini par d

2. Chargement x vignettes par affichage.

éfaut.

Utilisez la liste déroulante pour sélectionner le nombre de vignettes a afficher par écran : 4, 8 ou 12. La valeur par

défaut est 8.

3. Afficher la barre de progression.

Cochez cette case pour afficher la barre de progression lorsque vous copiez,

coupez et collez des documents et

des pages, ou encore lorsque vous supprimez des pages et enregistrez des documents.

4. [Enregistrer (Save)]
Cliquez sur ce bouton pour appliquer les nouveaux parametres.

5. [Réinitialiser (Reset)]
Cliquez sur ce bouton pour restaurer les parametres par défaut.

M Lien Connexion

Le lien Connexion situé prés des onglets principaux permet de se connecter en tant qu'administrateur systeme.

P.100 "Connexion en tant qu'administrateur systéme"

Vous pouvez exécuter les fonctions d'administration a partir de ['onglet [Administration] qui apparait une fois que

vous étes connecté en tant qu'administrateur systéme.

Menus de 'utilitaire Web e-Filing 39

LN3ITO ¥NILYNIQYO NN NS NOLLYSITILN



Gestion des répertoires et des dossiers utilisateur

L'utilitaire Web e-Filing fournit deux types de répertoire : le répertoire public et le répertoire utilisateur. Chaque
utilisateur peut créer son propre répertoire utilisateur dans lequel il peut également créer un niveau de dossiers.
Cette section explique comment effectuer les opérations suivantes :

P.40 "Création de répertoires et de dossiers utilisateur"

P.43 "Suppression de répertoires et de dossiers utilisateur"

P.44 "Renommer des répertoires et des dossiers utilisateur"

P.46 "Affichage et modification des propriétés des répertoires et des dossiers utilisateur"

Conseil

Pour plus d'informations sur le répertoire public et le répertoire utilisateur, reportez-vous a la section suivante :
P.8 "Fonctionnalités e-Filing"

B Création de répertoires et de dossiers utilisateur

Chaque utilisateur peut créer son propre répertoire utilisateur et, si nécessaire, le protéger a l'aide d'un mot de passe.
P.40 "Création de répertoires utilisateur"
P.41 "Création de dossiers"

QO Création de répertoires utilisateur
Il est possible de créer jusqu'a 200 répertoires utilisateur et de protéger chacun d'eux a 'aide d'un mot de passe.

Conseil

Vous pouvez également créer des zones utilisateur a partir de ['écran tactile. Pour plus d'informations sur la création
de zones utilisateur a partir de 'écran tactile, reportez-vous a la page suivante :
P.29 "Création de zones utilisateur"

1 Sélectionnez "e-Filing" dans le volet Document de l'onglet [Documents], puis [Nouvelle boite
(New Box)] dans le menu [Fichier (File)].

’@Electmnic Filing ;«L|
Document

e-Filin

g
[ Public Box
§a 001 UserBox01 1
F) 002 UserBox02
F) 003 UserBox03
&7l 004 UserBox04
&7l 005 UserBox05
{571 006 UserBox06
Fl 007 UserBox07

[1001 UserBox01 [oo2 userBox02 [l 003 userBox03

[Jo04 userBoxo4 [Joos userBoxos [oo6 userBoxo6 007 userBox07

La fenétre Nouveau répertoire apparait.

2 Définissez les propriétés du répertoire et terminez 'opération.
¢ [N° de la boite (Box Number)] : sélectionnez un numéro de boite.

Les utilisateurs ne peuvent pas sélectionner des numéros de répertoire existants dans la case "N° de
répertoire". Seuls les numéros de répertoires non définis apparaissent dans cette liste.

¢ [Nom de la boite (Box Name)] : saisissez le nom de la boite.
Les noms des boites peuvent étre composés de caracteres ASCIl a |'exception des suivants :
\/<>"%&=";:*?2|#[]{}
N'insérez pas d'espace ni de point au début ou a la fin du nom. Le nom d'un répertoire peut comporter au
maximum 32 caracteres.
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¢ [Mot de passe de la boite (Box Password)] / [Retaper mdp (Retype Password)] : pour protéger cette boite,

entrez un mot de passe dans |'un de ces champs.

New Box

*Required

Box Number:

* Box Name: ‘UserEuxOE

Box Password:
Retype Password

A\

Le répertoire utilisateur créé s'affiche dans le volet Document.

Conseil

Les utilisateurs peuvent paramétrer les propriétés avancées de chaque répertoire, par exemple la durée de
conservation des documents et les fonctionnalités de notification par e-mail.

P.46 "Modification des propriétés des répertoires"

O Création de dossiers

Il est possible de créer jusqu'a 100 dossiers par répertoire.

Remarque

Un seul niveau de dossiers peut étre créé par répertoire. Vous ne pouvez donc pas créer de sous-dossiers dans les
dossiers.

2

Dans le volet Document de l'onglet [Documents], sélectionnez la boite dans laquelle vous

souhaitez créer un dossier.

Electronic Filing

%

Document

5 e-Filing
&l @ Public Box

& 001 UserBox01
5 002 UserBox02
2l 003 UserBox03
4 004 UserBox04
i 005 UserBox05
;[ 006 UserBox06
&l 007 UserBox07

{8 eFiling (8 items)

7]

[Jpublic Box

[Joo1 userBoxo1

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].
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3 Sélectionnez [Fichier (File)] > [Nouveau dossier (New Folder)].

|Esmctmnicﬁring

Document

{E3 e-Filing

[ Public Box

B 5001 UserBox01
&) 002 UserBox02
Gl 003 UserBox03
Gl 004 UserBox04
%l 005 UserBox05
&l 006 UserBox06
&l 007 UserBox07

Rename

Archive Document
Upload Archived Document

Test Print
Print Document

Properties

Send Email

La fenétre Nouveau dossier apparait.

4 Saisissez le nom du dossier puis cliquez sur [OK].

New Folder

Name: ( ‘Fulderﬂﬂ

Le dossier créé s'affiche sous la boite sélectionnée dans le volet Document.

Remarque

Les noms de dossier sont composés de caracteres ASCII, a I'exception des suivants :

\/<>"%&=";:*?|#[]{}.

N'insérez pas d'espace ni de point au début ou a la fin du nom. Un nom de dossier peut comporter au maximum

64 caracteres.
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Bl Suppression de répertoires et de dossiers utilisateur
Il est possible de supprimer des répertoires et des dossiers utilisateur.

Remarque

Il est possible de supprimer les dossiers contenus dans la boite publique. En revanche, vous ne pouvez pas
supprimer la boite publique elle-méme.

La suppression d'un dossier ou d'une zone utilisateur entraine également la suppression des documents qu'ils
contiennent.

Conseil

2

Lorsque le répertoire est protégé par un mot de passe, ce dernier est demandé avant toute suppression. Les
utilisateurs disposant des droits d'administration peuvent supprimer tous les répertoires et dossiers utilisateur a
['aide de leur mot de passe.

Vous pouvez également supprimer des zones utilisateur a partir de |'écran tactile. Pour plus d'informations sur la
suppression de zones utilisateur a partir de |'écran tactile, reportez-vous a la page suivante :

P.31 "Suppression des zones et des dossiers utilisateur"

Dans le volet Document de l'onglet [Documents], sélectionnez la boite contenant les dossiers que
vous souhaitez supprimer.

| (@ Electronic Filing

Document 4B eFiling (8 items)

& e-Filina

& g Public Box

ﬁﬁ 001 UserBox01
A 002 UserBox02 8
57 003 UserBox03
%l 004 UserBox04
&l 005 UserBox05
&l 006 UserBox06
&l 007 UserBox07 [Jpublic Box [Joo1 userBoxo1

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

Pour supprimer une zone utilisateur, sélectionnez [Modifier (Edit)] > [Supprimer (Delete)]. Pour
supprimer un dossier, cochez les dossiers que vous souhaitez supprimer, puis sélectionnez
[Modifier (Edit)] > [Supprimer (Delete)].

| (¢ Electronic Filing

Document

1B e-Filing
(7 Public Box
= éﬁ 001 UserBox01

(=7 Foldero1

&g 002 UserBox02
57 003 UserBox03
& 004 UserBox04
&) 005 UserBox05
) 006 UserBox06
&) 007 UserBox07

Folder01

A

La boite de dialogue du message de confirmation apparait.
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Remarque

Vous pouvez également supprimer un dossier en le sélectionnant dans le volet Document, puis en sélectionnant
[Modifier (Edit)] > [Supprimer (Delete)]. Dans ce cas, vérifiez qu'aucun document n'est sélectionné dans le volet
Contenu. Si tel était le cas, le ou les documents seraient supprimés a la place du dossier sélectionné.

4 Cliquez sur [OK].

This site says...

Do you want to delete the item(s)?

Folder01

oK % Cancel

Les dossiers sélectionnés sont supprimés.

B Renommer des répertoires et des dossiers utilisateur
Les répertoires et les dossiers utilisateur peuvent étre renommés.

Remarque

* Vous pouvez renommer des dossiers de la boite publique, laquelle, en revanche, ne peut pas étre renommée.
* Ne mettez pas le systeme hors tension lors du changement du nom d'une boite ou d'un dossier. Vous risqueriez de
perdre tous les dossiers et documents présents dans la boite.

Conseil

* Lorsque le répertoire est protégé par mot de passe, les utilisateurs doivent saisir ce mot de passe pour renommer
les répertoires ou les dossiers. Les utilisateurs disposant des droits d'administration peuvent renommer tous les
répertoires et dossiers utilisateur a l'aide de leur mot de passe.

* Les utilisateurs peuvent renommer des zones utilisateur depuis le tableau de bord.

Pour plus d'informations sur la modification des noms de zone utilisateur depuis le tableau de bord, reportez-vous
a la section suivante :
P.30 "Modification des zones utilisateur"

Dans le volet Document de l'onglet [Documents], sélectionnez la zone utilisateur que vous
souhaitez renommer.

| (¢ Electronic Filing

Document 8 eFiling (8 items)
g e-Filing
=1 Public Box
| 001 UserBox01
& 002 UserBox02 @ h(a
5@ 003 UserBox03
5@ 004 UserBox04
i 005 UserBox05
i 006 UserBox06
&/ 007 UserBox07 [lpublic Box [Joa1 userBoxo1

2 Si vous sélectionnez une zone utilisateur protégée par mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion estimpossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].
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Pour renommer une zone utilisateur, sélectionnez [Fichier (File)] > [Renommer (Rename)].
Cochez le dossier que vous souhaitez renommer, puis sélectionnez [Fichier (File)] > [Renommer

(Rename)].

Electronic Filing

L -

Document

8 e-Filing
[ Public Box
E £ 001 UserBox01

(-] Foldero1

51 002 UserBox02
&) 003 UserBox03
Gl 004 UserBox04
&l 005 UserBox05
%l 006 UserBox06
gl 007 UserBox07

Archive D iment
Upload Ar.1\red Document

Test Print
Print Document

CFoldero1

La fenétre Renommer le répertoire apparait.

Remarque

* Ne sélectionnez pas plusieurs dossiers a la fois. Pour les renommer, sélectionnez-les ['un apreés l'autre.

* Vous pouvez également renommer un dossier en le sélectionnant dans le volet Document, puis en
sélectionnant [Renommer (Rename)] dans le menu [Fichier (File)]. Dans ce cas, vérifiez qu'aucun document
n'est sélectionné dans le volet Contenu. Si tel était le cas, le ou les documents seraient renommés a la place du
dossier sélectionné.

Modifiez le nom, puis cliquez sur [OK].

Rename Box

Name : |U5eron01

La boite de dialogue de confirmation s'affiche.

Remarque

Les noms des boites peuvent étre composés de caracteres ASCII a ['exception des suivants :
\/<>"%&=";:*?[#[]{}
N'insérez pas d'espace ni de point au début ou a la fin du nom. Le nom d'une boite peut comporter au maximum

32 caracteres, et celui d'un dossier, 64 caracteres.

Cliquez sur [OK].

This site says...

Do you want to rename the item?
oK

N

Cancel

A\

Le répertoire sélectionné est renommé.
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M Affichage et modification des propriétés des répertoires et des dossiers utilisateur

Il est possible d'afficher et de modifier les propriétés des répertoires utilisateur, notamment le mot de passe du
répertoire, la durée de conservation des documents et les paramétres de notification par e-mail. De méme, il est
possible d'afficher et de vérifier les propriétés des dossiers.

P.46 "Modification des propriétés des répertoires"

P.48 "Affichage des propriétés des dossiers"

Conseil

Lorsque le répertoire est protégé par mot de passe, vous devez saisir ce mot de passe pour en modifier les propriétés.
Les utilisateurs disposant des droits d'administration peuvent modifier toutes les propriétés des répertoires
utilisateur et celles du répertoire public a 'aide de leur mot de passe.

Q Modification des propriétés des répertoires

Remarque

* Sivous souhaitez modifier les propriétés du répertoire public, vous devez tout d'abord vous connecter en tant
qu'administrateur systeme.
* Il estimpossible de modifier le mot de passe d'un répertoire auquel un utilisateur est en train d'accéder.

Dans le volet Document de l'onglet [Documents], sélectionnez la zone utilisateur pour laquelle
vous souhaitez afficher et modifier les propriétés.

| (¢ Electronic Filing |

Document i e-Filing (8 items)
£ e-Filing
| g Public Box
gl 001 UserBox01
f) 002 UserBox02 @
i 003 UserBox03
i 004 UserBox04
£l 005 UserBox05
&l 006 UserBox06
Fi 007 UserBox07, CIPublic Box [Coo1 userBox01

2 Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

3 Sélectionnez [Fichier (File)] > [Propriétés (Properties)].

| (¢ Electronic Filing

Document
{E3 e-Filing
[f Public Bax -
(=] % 001 UserBox01 Upload Archived Document
(=] Folder01 TestPamt
&l 002 UserBox02 Print Document
&l 003 UserBox03
&l 004 UserBox04
&l 005 UserBox05
&l 006 UserBox06
gl 007 UserBox07

CIFoldero1

La fenétre Propriétés de la boite apparait.
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Si vous souhaitez modifier les propriétés du répertoire, cliquez sur [Modifier les propriétés
(Change Properties)].

Box Properties

Ea 001 UserBox01

Contains 0 File(s) 1 Folder(s)

Preservation Period for Documenis

Email Address for Notification -

Crealed - 05.10.2016 09:17:08
Wodified : 05.10.2016 09:43:09

Change Properties k

La fenétre Modifier les propriétés du répertoire apparait.

Conseil

Sivous ne voulez pas modifier les propriétés du répertoire, appuyez sur [OK] dans |'écran illustré ci-dessus afin
de terminer l'opération.

5 Paramétrez les éléments suivants comme il convient, puis appuyez sur [Enregistrer (Save)].

Change Box Properties

001 UserBox01

O Change Box Password
Old P

New

Confirm New

Change Preservation Period for Documents inside Box
[] Delete document automatically

Preservation Period for Documents : |1 days
e-Filing Notification Events
[} send Email when an error occurs
[] send Email when job is completed

Advance automatic delele nofification

Email Address - |

Advanced nofification is sent before the date of file deletion. -[3] day(s) notice.

Modifier le mot de passe de la boite — Activez cette case a cocher pour modifier le mot de passe de la boite.
- Ancien mot de passe — Saisissez le mot de passe actuel de la boite.

- Nouveau mot de passe — Saisissez le nouveau mot de passe de la boite.

- Confirmer nouveau mdp — Saisissez de nouveau le nouveau mot de passe de la boite.

Supprimer le document automatiquement — Activez cette case a cocher si vous souhaitez que les
documents de cette boite soient supprimés de fagon automatique.

Durée de conservation des documents — Saisissez le nombre de jours pendant lesquels les documents
doivent étre conservés. Les documents seront supprimés une fois cette période dépassée. Si vous définissez
une période d'un jour, les documents seront supprimés automatiquement au bout de 24 heures.

Envoyer un E-mail en cas d'erreur — Cochez cette case pour envoyer en cas d'erreur une notification a
['adresse électronique indiquée. Saisissez ensuite |'adresse électronique dans le champ [Adresse e-mail (Email
Address)].

Envoyer un E-mail a la fin d'un travail — Cochez cette case pour envoyer une notification a la fin d'un travail
a l'adresse électronique indiquée. Saisissez ensuite |'adresse électronique dans le champ [Adresse e-mail
(Email Address)].

Notification de suppression auto avancée — Activez cette case a cocher pour envoyer automatiquement un
message de notification a l'adresse électronique indiquée trois jours avant la suppression automatique des
documents. Saisissez ensuite |'adresse électronique dans le champ [Adresse e-mail (Email Address)].
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- Adresse E-mail — Saisissez |'adresse électronique a laquelle la notification doit étre envoyée. Vous ne

pouvez cocher cette option que lorsque le champ [Supprimer le document automatiquement (Delete
document automatically)] est sélectionné.

Remarque

Si un document est automatiquement supprimé par la fonction [Supprimer le document automatiquement
(Delete document automatically)], l'historique de suppression n'est pas conservé dans le journal. Pour plus
d'informations sur les journaux, reportez-vous au Guide de TopAccess.

Conseil

Sivous avez oublié ['ancien mot de passe, vous pouvez saisir a la place le mot de passe de |'administrateur dans
le champ [Ancien mot de passe (Old Password)].

Lorsque les options "Envoyer un E-mail en cas d'erreur" et "Envoyer un E-mail a la fin d'un travail" sont
sélectionnées, un message de notification est envoyé pour indiquer si les opérations e-Filing suivantes se sont
correctement déroulées :

* Numériser vers e-Filing

* Copier vers e-Filing

* Imprimer vers e-Filing

* Transmission de fax/fax Internet recus vers e-Filing

* E-Filing vers impression

* E-Filing vers e-mail

L'administrateur peut paramétrer |'option de notification pour les opérations e-Filing dans TopAccess, sous

['onglet [Administration] > Maintenance > page Notification. Pour plus d'informations, reportez-vous au Guide de
TopAccess.

Cliquez sur [OK] pour fermer la fenétre des propriétés du répertoire.

Box Properties

001 UserBox01

Contains 0 File(s) 1 Folder(s)

Preservation Period for Documents

Email Address for Notification :

Created - 05.10.2016 09:17:09
Modified 05102016 09:43:09

Change Properties

QO Affichage des propriétés des dossiers

Vous pouvez uniquement afficher et vérifier les propriétés des dossiers. Vous ne pouvez pas les modifier.

Dans le volet Document de l'onglet [Documents], sélectionnez la boite contenant le dossier dont
vous souhaitez afficher les propriétés.

| (@ Electronic Filing

Document i eFiling (8 items)
45 eFiling

* (gl Public Box

"l 001 UserBox01
jil 002 UserBox02 Ea
£1003 UserBox03

il 004 UserBox04
&l 005 UserBox05
&l 006 UserBox06
[t ) 007 UserBox07 Cpublic Box oot usergoxo1

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].
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Remarque

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

Cochez la case du dossier dont vous souhaitez afficher les propriétés et sélectionnez [Fichier
(File)] > [Propriétés (Properties)].

| (¢ Electronic Filing
il ERENE )

Document
& e-Filing
[l Public Box

ment
B % 001 UserBox01 Upload Archived Document
] Foldero1 —

Test Print
&l 002 UserBox02 Print Document

&7l 003 UserBox03
gl 004 UserBox04
& 005 UserBox05
&fl 006 UserBox06
&l 007 UserBox07

Foldero1

) |
La fenétre Propriétés du dossier apparait. Elle affiche les propriétés du dossier.

Remarque

* Nesélectionnez pas plusieurs dossiers a la fois. Vous ne pouvez en effet afficher les propriétés que d'un dossier
a la fois.

* Vous pouvez également afficher les propriétés d'un dossier en sélectionnant le dossier dans le volet
Document, puis en cliquant sur [Propriétés (Properties)] dans le menu [Fichier (File)]. Dans ce cas, vérifiez
qu'aucun document n'est sélectionné dans le volet Contenu. Si un document est sélectionné, ses propriétés
sont affichées a la place du dossier spécifié.

Cliquez sur [OK] pour fermer la fenétre Propriétés du dossier.

Folder Properties

D Folder01

Location : e-Filing/UserBox01/Felder01
Contains : 0 File(s)

Created : 05.10.2016 09:05:34
Modified : 05.10.2016 09:05:34

)

La fenétre Propriétés du dossier contient les informations suivantes :
¢ Emplacement — Affiche le répertoire dans lequel se trouve le dossier.

¢ Contenu — Affiche le nombre de fichiers contenus dans le dossier.
* Créé — Affiche la date et ['heure de création du dossier.

* Modifié(e) — Affiche la date et 'heure de la derniére modification du dossier.
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Gestion de documents

L'utilitaire Web e-Filing permet de gérer les documents stockés dans les boites e-Filing.
Cette section explique comment effectuer les opérations suivantes :

P.50 "Affichage des documents"

P.51 "Renommer des documents"

P.53 "Suppression de documents"

P.54 "Impression de documents"

P.59 "Stockage de documents avec le pilote d'impression”

P.62 "Archivage de documents”

P.66 "Envoi d'un message électronique”

H Affichage des documents

Vous pouvez afficher vos fichiers d'images de documents de deux fagons. Les options d'affichage des documents sont
les suivantes:

* Miniature
Le mode Vignettes affiche plusieurs fichiers d'un répertoire ou d'un dossier sélectionné ou encore de plusieurs
pages d'un document sélectionné. Il s'agit du mode d'affichage défini par défaut. Utilisez-le pour gérer vos
documents et fichiers.
P.50 "Utilisation du mode Vignettes"

* Liste
Le mode Liste affiche les propriétés et les noms de fichier sous forme de tableau. Utilisez ce mode pour gérer les
répertoires et dossiers contenant un grand nombre de fichiers.
P.51 "Utilisation du mode Liste"

QO Utilisation du mode Vignettes

Sivous n'en avez pas choisi un autre, le mode Vignettes est défini par défaut. Il affiche sous forme de vignette chaque
fichier ou dossier que vous avez sélectionné dans le volet de gauche, ou encore chaque page d'un document avec le
nom du fichier ou le numéro de la page, ainsi qu'une case a cocher. Activez les cases des pages ou fichiers a déplacer,
copier, supprimer ou imprimer.

Pour retourner a 'affichage des vignettes, cliquez sur [Affichage (View)] > [Vignettes (Thumbnail)].

|@Eiectronic Filing I Loon

Document | DOC051016-001 (1/3) Status : View
{8 e-Filing

Ea Public Box

= @ 001 UserBox01 — =2

(] Foldero1

[& DOCO51016

|& DOC051016-00 /4 | I

i1 002 UserBox02 | =)

571003 UserBox03 A

&7 004 UserBox04
571 005 UserBox05
&1 006 UserBox06
£l 007 UserBox07 [lpages 1 [pages 2 [rages 3
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O Utilisation du mode Liste

Ce mode affiche, sous forme de liste, les noms des fichiers, dossiers ou répertoires ainsi que leurs propriétés et les
cases a cocher correspondantes. Il se peut que vous trouviez ce mode plus pratique que le mode Vignettes pour gérer
les répertoires et dossiers contenant un grand nombre de fichiers. Activez les cases des fichiers a déplacer, copier,
supprimer ou imprimer.
Pour afficher les fichiers en mode Liste, cliquez sur [Affichage (View)] > [Liste (List)].

| (@ Electronic Filing

Document
{8 e-Filing
[fl Public Box
El 4 001 UserBox01
(] Foldero1
% DOCO051016
E DOC051016-00|
51 002 UserBox02
571003 UserBox03
&7 004 UserBox04
ga 005 UserBox05
&1 006 UserBox06
&7 007 UserBox07

| DOC051016-001 (1/3)

Pages#

m} Pages 1
[ pages 2
O Pages 3

Hl Renommer des documents

Status : View
Format Resclution Image Size Paper Size Size
Scan  200x200 1646x 2331 Ad 306 KB
Scan  200x200 1646x 2331 A4 409 KB
Scan  200x200 1646x 2331 Ad 474 KB

Les documents peuvent étre renommeés.

Remarque

32015 TOSHIBA TEC CORFORATION Al Rights Reserved

Lorsque vous modifiez le nom d'un document, ne mettez pas le systéme hors tension tant que le nouveau nom n'est
pas sauvegardé ; vous risqueriez de perdre votre document.

1

2

Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant le
document que vous souhaitez renommer.

| (¢ Electronic Filing |

Document
@ e-Filinn

[l Public Bax

ga 001 UserBox01
£l 002 UserBox02
&l 003 UserBox03
& 004 UserBox04
& 005 UserBox05
&7l 006 UserBox06
gl 007 UserBox07

{f e-Filing (8 items)

]

Opublic Box

ooz usergoxo1

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un accés non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion estimpossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].
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3 Cochez le document a renommer et sélectionnez [Fichier (File)] > [Renommer (Rename)].

| (@ Electronic Filing

Document
& e-Filing
£ [ Public Box : .
=l g 001 UserBox01 2 —
] Folder01 — easesans

[& DOCO51016 Print Do
[ DOCO51016-00| e 4_” [ |
5 002 UserBox02 L ,\f .
& 003 UserBox03 e — .
&l 004 UserBox04
& 005 UserBox05 [

5] 006 UserBoxD6 CFoldero1
57 007 UserBox07 DOCO51016
[Scan]
|A¥-
Al |

La fenétre Renommer Document apparait.

Conseil

Les utilisateurs peuvent également renommer un document en le sélectionnant dans le volet Document, puis
[Fichier (File)] > [Renommer (Rename)].

4 Saisissez le nom du document et cliquez sur [OK].

Rename Document

Name GDOCDHUWE ]

La boite de dialogue de confirmation s'affiche.

Remarque

Les noms des documents sont composés de caractéres ASCII a 'exception des suivants :
\/<>"%&=";:*?2|#[]{}

N'insérez pas d'espace ni de point au début ou a la fin du nom. Un nom de document peut comporter au
maximum 64 caracteres.

5 Cliquez sur [OK].

This site says...

Do you want to rename the item?

oK Cancel

N

A\

Le document est renommé.
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l Suppression de documents

Il est possible de supprimer des documents d'un répertoire ou d'un dossier.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant les

documents que vous souhaitez supprimer.

| (¢ Electronic Filing |

Document

{& e-Filing (8 items)

a-Filina
=l [ Public Box

&7 001 UserBox01
57 002 UserBox02 Ga
&) 003 UserBox03
&) 004 UserBox04
&g 005 UserBox05
&g 006 UserBox06

{ 57 007 UserBox07 Opublic Box

oot userBoxo1

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification

par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion estimpossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

Cochez les documents que vous souhaitez supprimer, puis sélectionnez [Modifier (Edit)] >

[Supprimer (Delete)].

| (¢ Electronic Filing

Document
4{Ea e-Filing

=l F Public Box
=] % 001 UserBox01

La boite de dialogue de confirmation s'affiche.

Remarque

(~) Feolder01
[& DOC051016 |
& DOC051016-00 D 2 Zl” B
571002 UserBox02 \/ /
571 003 UserBox03 L
EB 004 UserBox04
EB 005 UserBox05
571006 UserBox06 [IFoldero1
571007 UserBox07 DOC051016
[Scan]
.
Al |

Les utilisateurs peuvent également supprimer un document en le sélectionnant a partir du volet Documents,
puis [Modifier (Edit)] > [Supprimer (Delete)]. Dans ce cas, vérifiez qu'aucune page n'est sélectionnée dans le volet
Contenu. Si tel était le cas, un message d'alerte vous indiquerait que la suppression de pages est impossible en

mode d'affichage.

Cliquez sur [OK].

This site says...

Do you want to delete the item(s)?

DOC051016

OK % Cancel

Les documents sont supprimés.
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H Impression de documents

Vous pouvez imprimer des documents et des images a partir des répertoires et dossiers de 'utilitaire Web e-Filing.
Pour cela, vous disposez des deux méthodes suivantes :

P.54 "Impression de l'intégralité d'un document"
[0 p.57 "Test d'impression"

QO Impression de l'intégralité d'un document

Vous pouvez imprimer l'intégralité d'un document en sélectionnant diverses options d'impression.

Dans le volet Document, sélectionnez la boite ou le dossier contenant le document que vous

souhaitez imprimer.

| (¢ Electronic Filing |

Document {8 e-Filing (8 items)
@ a-Filina

=l [g Public Box

&p) 001 UserBox01
57 002 UserBox02 Ea ﬁa
&) 003 UserBox03 &
&) 004 UserBox04
&6 005 UserBox05
&g 006 UserBox06
& 5 007 UserBox07 [ public Box o1 UserBox01

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion estimpossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de

passe de la boite (Box Password)].

Cochez la case du document a imprimer et sélectionnez [Fichier (File)] > [Imprimer le document

(Print Document)].

| (¢ Electronic Filing

Document
4{Ea e-Filing

=l F Public Box
=] % 001 UserBox01
(~) Feolder01
% DOC051016
% DOC051016-00
571 002 UserBox02
571 003 UserBox03
&p] 004 UserBox04
&pl 005 UserBox05
571006 UserBox06 [IFoldero1

571007 UserBox07 DOC051016
[Scan]

La fenétre Imprimer apparait.

Remarque

Vous pouvez également imprimer un document en le sélectionnant dans le volet Document et en cliquant sur
[Fichier (File)] > [Imprimer le document (Print Document)]. Toutefois, vous ne pouvez pas imprimer de pages
individuelles méme en activant leurs cases a cocher dans le volet Contenu.
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4

Paramétrez les options ci-dessous comme il convient et cliquez sur [Imprimer (Print)].

Print
Duplex: Cover/Sheet Insertion:
Number of Copies: l:l —A‘J [ use Front Cover
® Sort Copies Source: Auto Select hd
Group Copies JJJJJJ Print Style: Do not print on page W
Rotate Sort Copies : : [ use Back cover
Paper Type: Source: Auto Select v
Toner Mode: Print Do not print on page b
Department Code: _
Project Code: _ [ tnsert Pages
Paper Source: \Auto Select V| Source: Auto Select W
Destination: Print Style: Do not print on page w
staple: J Pages: |
Binding: J JJ [ tnterieave Pages
Hole Punch: Source: Auto Select hd
Page Number: Duplicate
Position: Paper Type (Insert): [Plain v
Initial Page: - [ scheduled Print
Year Month Date Time
Time Stamp: pateeTime: 2007 w|[1 v [6 v [ : I
positin:
Image Shift:
position:
Shift Margin:
Front: 0~ mm
Back: 0 ¥ mm
PrinT Cancel Reset
A\)

* Recto verso — Cette option permet d'imprimer le document sur les deux faces du papier. Vous pouvez choisir

entre Livret ou Bloc-notes.

Nombre de copies — Saisissez le nombre de copies a imprimer.

Copies triées — Sélectionnez cette option pour séparer les exemplaires du document imprimé.
Copies groupées — Sélectionnez cette option pour séparer chaque page du document imprimé.

Copies tri en alternance — Sélectionnez cette option pour que chaque copie du document sorte dans une
orientation différente.

Type de papier — Sélectionnez le type de papier souhaité.

Mode toner — Sélectionnez cette option pour spécifier le toner a utiliser pour l'impression. Cette option n'est
disponible qu'avec la série e-STUDIO5008LP.

Code départemental — Saisissez un code départemental de 1 a 63 chiffres, si nécessaire. La saisie d'un code
départemental est requise avant l'impression d'un document si la fonction de gestion par codes
départementaux est activée sur le systeme.

Code projet : Saisissez un code projet de 1 a 63 chiffres, si nécessaire. Si la fonction code projet est activée sur
le systéme, vous devez entrer ce code pour imprimer un document.

Source papier — Sélectionnez la source pour l'alimentation papier. Sélectionnez une source de papier
correspondant au format de l'impression.

Destination — Sélectionnez le bac de sortie du document.
Agrafer — Indiquez si le document doit étre agrafé. Le cas échéant, indiquez de quelle facon.

Reliure — Sélectionnez cette option pour que le document soit plié ou agrafé au centre a sa sortie. Vous
pouvez définir le mode de reliure du document a sa sortie.

- Pliage central: le document est plié au centre.
- Agrafage a cheval: le document est agrafé en deux points et plié au centre.

Perforation — Cette option permet de perforer le document. Le cas échéant, indiquez de quelle facon.
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* Numéro de page : cette option permet d'imprimer les numéros de page.
- Position : cette option permet d'imprimer les numéros de page. Le cas échéant, indiquez a quel endroit.

- Premiére page : saisissez le numéro qui doit apparaitre sur la premiére page du document. Lorsque
['option "Insertion intercal./couverture - Ajouter couv. avant" est sélectionnée, la couverture correspond a
la premiere page et la premiére page du document a la deuxieme page.

* Date/Heure: cette option permet d'imprimer la date et ['heure sur chacune des pages.

- Position : sélectionnez cette option pour imprimer la date et ['heure sur chaque page. Le cas échéant,
indiquez l'endroit ol ces données devront apparaitre.

* Décalage d'image : cette option permet de décaler les images imprimées.
- Position : sélectionnez cette option si vous souhaitez décaler les images imprimées.

- Décalage marge - Avant — Sélectionnez la largeur de la marge qui doit &tre ajoutée pour décaler l'image
du document vers l'avant.

- Décalage marge - Arriére — Sélectionnez la largeur de la marge qui doit étre ajoutée pour décaler l'image
du document vers 'arriére.

* Insertion intercal./couverture : sélectionnez cette option si vous souhaitez imprimer la premiére ou la
quatrieme de couverture.

- Ajouter couv. avant : cette option d'impression d'une couverture avant permet d'insérer ou d'imprimer
une couverture sur une feuille provenant d'un autre bac que celui défini par |'option Source papier. Pour
activer l'impression d'une couverture avant, cochez cette case et sélectionnez la source d'alimentation de
la feuille de couverture ainsi que le style d'impression a utiliser.

- Ajouter couv. arr. : cette option d'impression permet d'insérer ou d'imprimer une quatrieme de
couverture sur une feuille provenant d'un autre bac que celui défini par |'option Source papier. Pour activer
l'impression d'une quatrieme de couverture, cochez cette case et sélectionnez la source d'alimentation de
la feuille de couverture, ainsi que le style d'impression a utiliser.

- Intercalaires : cette option d'impression permet d'insérer une feuille entre deux pages ou d'imprimer une
page spécifique sur une feuille provenant d'un bac autre que celui défini par ['option Source papier. Cette
option est utile pour insérer une feuille vierge entre deux chapitres ou pour imprimer les pages de titre de
chapitre sur du papier différent. Pour activer |'impression d'intercalaires, cochez cette case et sélectionnez
la source d'alimentation, ainsi que le style d'impression a utiliser. Saisissez ensuite, dans le champ [Pages],
les numéros des pages auxquelles des feuilles sont a insérer et séparez-les par des virgules si plusieurs
pages sont spécifiées.

- Interfoliage : cette option permet de définir la fonction d'interfoliage qui est utile si vous souhaitez insérer
du papier dont le type ou la source est différente entre chaque page de votre travail d'impression. Vous
pouvez par exemple utiliser cette option pour insérer des feuilles vierges de couleur entre des transparents.
Pour activer |'option d'interfoliage, cochez cette case et spécifiez la source d'alimentation. Activez
également la case a cocher [Dupliquer (Duplicate)] si vous souhaitez imprimer les images des pages
précédentes sur les feuilles insérées.

- Type de papier (Insert) — Lorsque vous sélectionnez le mode d'alimentation manuelle (bypass) dans la
liste déroulante Source de l'option "Ajouter couv. avant", "Ajouter couv. arr.", "Intercalaires" ou
"Interfoliage", sélectionnezici le type de papier a insérer depuis le bypass.

* Impression programmée — Activez cette case a cocher pour imprimer un travail a une date et une heure
ultérieures. Lorsque cette option est sélectionnée, définissez la date et I'heure auxquelles le travail doit étre
imprimé dans le champ [Date et heure (Date & Time)].

Remarque

* Laplage du nombre de copies que vous pouvez sélectionner change en fonction du modele.

» L'option [Copies tri en alternance (Rotate Sort Copies)] est activée uniquement lorsque vous saisissez un
chiffre supérieur a 1 dans le champ [Nombre de copies (Number of Copies)]. Pour réaliser des copies avec tri en
alternance, du papier au format Portrait et Paysage doit étre placé dans deux cassettes distinctes. Le bac de
sortie interne est quant a lui automatiquement défini comme destination si vous sélectionnez cette option.

* Lesfonctions "Agrafage", "Reliure" et "Perforation" sont uniquement activées lorsqu'une unité (facultative)
correspondante est installée. Pour plus d'informations sur le style de finition et les options requises, reportez-
vous au Guide des caractéristiques.

* Lesoptions "Agrafage" et "Insertion intercal./couverture - Interfoliage" ne peuvent pas étre activées en méme
temps. L'activation de ['une de ces options entraine la désactivation automatique de ['autre.
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Conseil

* Cliquez sur [Imprimer (Print)] pour imprimer le document et afficher la fenétre de résultat de l'impression.

* Cliquez sur [Annuler (Cancel)] pour fermer la fenétre d'impression sans imprimer.

* Cliquez sur [Réinitialiser (Reset)] pour restaurer les parameétres par défaut des propriétés d'impression.

* Lorsque l'option [Insertion intercal./couverture - Ajouter couv. avant (Cover/Sheet Insertion - Use Front
Cover)] est sélectionnée, la premiére de couverture est considérée comme la page 1 et les numéros des pages
imprimées commencent a 2.

* Lorsque les parameétres de gestion des utilisateurs et ceux de gestion par codes départementaux sont activés,
les quotas autorisés pour le département et ['utilisateur s'affichent dans la zone supérieure droite de la page.

5 Cliquez sur [Fermer (Close)] pour revenir a la page de 'onglet [Documents].

Conseil

Lorsque vous souhaitez annuler un travail avant la fin de l'impression, accédez a TopAccess, cliquez sur 'onglet
[Etat trav. (Job Status)] > [Imprimer (Print)], sélectionnez le travail, puis appuyez sur [Supprimer (Delete)].

0 Test d'impression

Cette fonction permet tout simplement d'imprimer une copie d'un document selon les parametres d'impression
définis.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant le
document que vous souhaitez imprimer.

() Electronic Filing
Edit View Layout

Document 48 e-Filing (8 items)
B e-Filina
[ Public Box
&0 001 UserBox01
&7 002 UserBox02 @ Ea
5@ 003 UserBox03
5@ 004 UserBox04
& 005 UserBox05
& 006 UserBox06
(£ fr] 007 UserBox07 O public Box Cloo1 userBoxo1

2 Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion estimpossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].
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3 Cochez la case du document a imprimer et sélectionnez [Fichier (File)] > [Test d'impr. (Test
Print)].

| (@ Electronic Filing

Document
4 e-Filing

=1 [ Public Box
=] $ 001 UserBox01
] Folder0o1
E DOCO051016
E DOC051016-00
i 002 UserBox02
& 003 UserBox03
&l 004 UserBox04
&l 005 UserBox05
&/l 006 UserBox06
&l 007 UserBox07

[IFoldero1
DOCO51016
[Scan]

N |
La fenétre Test d'impression apparait.

Remarque

Vous pouvez également effectuer un test d'impression en sélectionnant un document dans le volet Document,
puis en cliquant sur [Fichier (File)] > [Test d'impr. (Test Print)]. Toutefois, vous ne pouvez pas imprimer de pages
individuelles méme en activant leurs cases a cocher dans le volet Contenu.

4 Indiquez si vous souhaitez imprimer toutes les pages du document ou uniquement les pages
spécifiées, puis cliquez sur [Imprimer (Print)].

Test Print

® Al Pages Department Code Project Code
Of J-f Jraes [
Toner ode

* Toutes les pages — Sélectionnez cette option pour imprimer toutes les pages du document.

* [premier numéro de page] - [dernier numéro de page] Pages — Sélectionnez cette option pour indiquer les
pages a imprimer. Lorsque cette option est sélectionnée, saisissez le numéro de la premiere et de la derniére
page a imprimer dans leurs champs respectifs.

* Code départemental — Saisissez le code départemental. Vous devez saisir ce code uniquement si la fonction
de gestion par codes départementaux est activée sur le systéeme.

¢ Code projet : saisissez un code projet. Il ne doit &tre saisi que si la fonction code projet est activée sur le
systeme.

¢ Mode toner — Sélectionnez cette option pour spécifier le toner a utiliser pour l'impression. Cette option n'est
disponible qu'avec la série e-STUDIO5008LP.

Conseil

* Lorsque les parametres de gestion des utilisateurs et ceux de gestion par département sont activés, les quotas
autorisés pour le département et |'utilisateur s'affichent dans la zone supérieure droite de la page.

* Cliquez sur [Imprimer (Print)] pour imprimer une copie du document et afficher la fenétre de résultat de
l'impression.

* Cliquez sur [Annuler (Cancel)] pour fermer la fenétre d'impression de test sans imprimer.

5 Cliquez sur [Fermer (Close)] pour revenir a la page de l'onglet [Documents].

Remarque

Lorsque vous souhaitez annuler un travail avant la fin de l'impression, accédez a TopAccess, cliquez sur l'onglet
[Etat trav. (Job Status)] > [Imprimer (Print)], sélectionnez le travail, puis appuyez sur [Supprimer (Delete)].
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l Stockage de documents avec le pilote d'impression

A partir d'une application s'exécutant sous le systeéme d'exploitation Windows, vous pouvez envoyer un document
sous forme de travail d'impression vers e-Filing avec le pilote de l'imprimante.

Vous pouvez stocker vos documents dans le répertoire public ou dans un répertoire utilisateur.

P.59 "Enregistrement d'un travail d'impression dans le répertoire public"

P.60 "Enregistrement d'un travail d'impression dans un répertoire utilisateur"

Remarque

Lorsque vous utilisez le pilote d'impression pour stocker un document dans e-Filing, c'est l'image d'impression (et
non le document original enregistré sur votre ordinateur) qui y sera stockée.

Conseil

* Pour plus d'informations sur le pilote d'impression, reportez-vous au Guide de l'impression.

* Pour plus d'informations sur le répertoire public et le répertoire utilisateur, reportez-vous a la section suivante :
P.8 "Fonctionnalités e-Filing"

* Vous pouvez également stocker un document numérisé dans l'e-Filing en utilisant ['écran tactile. Pour plus
d'informations, reportez-vous a la section suivante :
P.19 "Stockage de documents"

QO Enregistrement d'un travail d'impression dans le répertoire public

1 Ouvrez le document que vous souhaitez stocker dans le répertoire.

2 Dans l'application, cliquez sur [Fichier (File)] > [Imprimer (Print)].
La boite de dialogue [Imprimer (Print)] apparait.

3 Sélectionnez le pilote d'impression du systéme a utiliser et cliquez sur [Préférences
(Preferences)].
La boite de dialogue [Options d'impression (Printing Preferences)] apparait.

Conseil

La procédure d'affichage de la boite de dialogue [Options d'impression (Printing Preferences)] pour le pilote
d'impression peut varier en fonction de l'application que vous utilisez. Reportez-vous a la documentation de
votre application sur l'affichage de la boite de dialogue [Options d'impression (Printing Preferences)].

4 Sélectionnez le type de travail d'impression dans l'onglet [Basique].
Sélectionnez [Stocker vers e-Filing] dans la liste déroulante [Travail d'impression].
Si nécessaire, sélectionnez d'autres options d'impression.

Conseil

* Un travail d'impression est enregistré a l'aide de ['option d'impression définie.

* Pour les séries e-STUDIO5005AC, e-STUDIO5008A, e-STUDIO7506AC, e-STUDIO8508A
Les options d'impression autres que [Nombre de copies (Number of Copies)] sont définies dans un travail et
enregistrées dans la boite publique.

* Pour la série e-STUDIO5008LP
Les options d'impression autres que [Nombre de copies (Number of Copies)] et [Mode toner (Toner Mode)]
sont définies dans un travail et enregistrées dans la boite publique.
Sivous essayez d'imprimer un travail dans la boite publique, méme si le parametre [Mode toner (Toner Mode)]
dans l'onglet [Principal (Basic)] est modifié, ['opération ne sera pas reflétée sur l'impression.
L'impression sera effectuée avec le paramétre suivant du [Mode toner (Toner Mode)].

- Le parametre par défaut du [Mode toner (Toner Mode)] est défini dans TopAccess.
- Le parameétre est défini dans [Parameétres (Settings)] dans le répertoire e-Filing spécifié sur ['écran tactile du
systéme.
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Appuyez sur [...] en regard de la boite [Travail d'impression (Print Job)]. La boite de dialogue [Stock. vers e-Filing
(Store to e-Filing)] s'affiche.

= Printing Preferences X
Basic  Finishing PaperHanding Image Qualty Effect Others Templates

Print Job: Original Paper Size:

Ad (210 x 297mm) ~
=} Nomnal #rint Print Paper Size: [Jimage Scale:
(U Scheduled Print 25 Same as Original Size ~| oo |2 %25-400)
& Private Print
B Proof Print Paper Source:
[ Hold Print % Adto -
E#? Mutti Station Print =
. ) Paper Type:
+¥ Print to Overlay File
N Store o e-Filing Plain (16-21lb.bond) v
Destination:
ic:: [ v

%
%1 o %1.2.3

Settings...

Number of Copies: f =] (1-999)
bt
Mone i Orientation:

Saye Profile | | Delete O Portrait ® Landscape

R

Cancel Help

Restore Defaults owy Color

Auto v

5 Sélectionnez [Boite publique (Public Box)] pour enregistrer le travail-d'impression et cliquez sur

[OK].
Store to e-Filing x
Store to:
Public Box ~
Box Folder: 1
[ Print
Conseil

* Sivous voulez enregistrer un travail d'impression dans un dossier spécifique, indiquez le nom du dossier dans
le champ [Dossier (Box Folder)].
Pour enregistrer les données dans un dossier existant, indiquez le nom du dossier dans le champ [Dossier (Box
Folder)].
Pour enregistrer les données dans un nouveau dossier, indiquez le nom de ce dernier dans le champ [Dossier
(Box Folder)].

* Sivous voulez imprimer un travail tout en |'enregistrant dans la boite publique, activez la case a cocher
[Imprimer (Print)].
Un travail sera imprimé avec le parametre [Couleur (Color)] ou [Mode toner (Toner Mode)] dans l'onglet
[Principal (Basic)].

Cliquez sur [OK] ou sur [Imprimer (Print)] pour enregistrer le travail d'impression.
Le travail d'impression est enregistré dans le répertoire public spécifié.

QO Enregistrement d'un travail d'impression dans un répertoire utilisateur

1 Ouvrez le document que vous souhaitez stocker dans le répertoire.

2 Dans l'application, cliquez sur [Fichier (File)] > [Imprimer (Print)].
La boite de dialogue [Imprimer (Print)] apparait.

3 Sélectionnez le pilote d'impression du systéme a utiliser et cliquez sur [Préférences
(Preferences)].
La boite de dialogue [Options d'impression (Printing Preferences)] apparait.

Conseil

La procédure d'affichage de la boite de dialogue [Options d'impression (Printing Preferences)] pour le pilote
d'impression peut varier en fonction de l'application que vous utilisez. Reportez-vous a la documentation de
votre application sur l'affichage de la boite de dialogue [Options d'impression (Printing Preferences)].
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Sélectionnez le type de travail d'impression dans l'onglet [Basique].
Sélectionnez [Stocker vers e-Filing] dans la liste déroulante [Travail d'impression].
Si nécessaire, sélectionnez d'autres options d'impression.

Conseil

* Untravail d'impression est enregistré a l'aide de |'option d'impression définie.

* Pour les séries e-STUDIO5005AC, e-STUDIO5008A, e-STUDIO7506AC, e-STUDIO8508A
Les options d'impression autres que [Nombre de copies (Number of Copies)] sont définies dans un travail et
enregistrées dans la boite utilisateur.
* Pour la série e-STUDIO5008LP
Les options d'impression autres que [Nombre de copies (Number of Copies)] et [Mode toner (Toner Mode)]

sont définies dans un travail et enregistrées dans la boite utilisateur.

Sivous essayez d'imprimer un travail dans la boite utilisateur, méme si le paramétre [Mode toner (Toner
Mode)] dans l'onglet [Principal (Basic)] est modifié, |'opération ne sera pas reflétée sur l'impression.
L'impression sera effectuée avec le paramétre suivant du [Mode toner (Toner Mode)].

- Le parameétre par défaut du [Mode toner (Toner Mode)] est défini dans TopAccess.
- Le parameétre est défini dans [Parameétres (Settings)] dans le répertoire e-Filing spécifié sur ['écran tactile du
systéme.

Appuyez sur [...] en regard de la boite [Travail d'impression (Print Job)]. La boite de dialogue [Stock. vers e-Filing

- %(25-400)

- o fc:
(Store to e-Filing)] s'affiche.
® Printing Preferences
Basic  Finishing PaperHanding Image Qualty Effect Others Templates
Print Job: Original Paper Size:
=] Normal Print :L A4 (210 % 257mm) =
E Nwma\Prml_ Print Paper Size: [Jimage Scale:
(O Scheduled Print 2_5 Same as Original Size ~| 100
¢ Private Print
Elii Proof Print Paper Source:
=M Hold Print % Auto -
E#* Multi Station Print =
Paper Type:
+%€ Print to Overlay File
T 3 ST Plain (16-211b.bond) ~
Destination:
i T ~
JA" ik JAT i}
E
Settings..
Murmber of Capies: 0 [ am
Profile:
None hd Orientation:
Save Profile | | Delete O Portrait ® Landscape
Restore Defaults opy Lolor
**e lAuto v|| De
Cancel

Ry

Help

Sélectionnez le répertoire utilisateur dans lequel vous voulez enregistrer le travail d'impression.
¢ Sélectionnez le numéro de répertoire utilisateur désiré dans la liste [Stocker dans (Stock to)].

* Saisissez le mot de passe du répertoire utilisateur dans le champ [Mdp (Password)].

* Sivous voulez imprimer un travail tout en l'enregistrant dans le répertoire utilisateur, activez la case a cocher
[Imprimer (Print)].

Store to e-Filing

Store to:
001 User(1

Box Folder:

Password:

Folder01
[ Print
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Conseil

* Sivous voulez enregistrer un travail d'impression dans un dossier spécifique, indiquez le nom du dossier dans
le champ [Dossier (Box Folder)].
Pour enregistrer les données dans un dossier existant, indiquez le nom du dossier dans le champ [Dossier (Box
Folder)].
Pour enregistrer les données dans un nouveau dossier, indiquez le nom de ce dernier dans le champ [Dossier
(Box Folder)].

* Sivous voulez imprimer un travail tout en |'enregistrant dans la boite publique, activez la case a cocher
[Imprimer (Print)]. Un travail sera imprimé avec le paramétre [Couleur (Color)] ou [Mode toner (Toner Mode)]
dans l'onglet [Principal (Basic)].

Remarque

Si la case a cocher "Activer la communication SNMP" de |'onglet [Configuration] est activée, seules les zones
utilisateur qui ont été paramétrées seront affichées dans la liste déroulante.

6 Cliquez sur [OK] ou sur [Imprimer (Print)] pour enregistrer le travail d'impression.
Le travail d'impression est enregistré dans le répertoire utilisateur spécifié.

H Archivage de documents

L'utilitaire Web e-Filing permet d'archiver les documents stockés dans le répertoire e-Filing et de charger le fichier
archivé sur votre ordinateur. Ces fichiers peuvent également étre chargés depuis votre ordinateur vers le systeme
e-Filing de ce systeme ou de tout autre systeme de la méme gamme e-STUDIO.

P.62 "Chargement d'un document archivé"

P.64 "Chargement des documents archivés"

Conseil

Les fichiers archivés sont compatibles avec la méme série que le systéme multifonction TOSHIBA, mais pas avec une
autre série.

O Chargement d'un document archivé

Vous pouvez archiver les documents dans la boite et les charger sur votre ordinateur. Utilisez cette fonction pour
créer un fichier de sauvegarde de vos documents dans e-Filing.

La procédure ci-dessous décrit la procédure de chargement d'un document archivé a l'aide de Microsoft Internet
Explorer.

Remarque

* Le fichier archivé contient tous les documents que vous avez spécifiés pour l'archivage, lesquels ne peuvent pas
étre ouverts sur votre ordinateur

* Vous pouvez créer un fichier archivé contenant les documents d'un méme dossier ou d'un méme répertoire.

* Vous pouvez créer un fichier archivé contenant plus de 2 Go de données.

* Ne fermez pas la fenétre principale ni la fenétre enfant en cliquant sur le bouton [X]. Cette opération rendrait en
effet impossible le chargement des documents archivés. Si vous fermez la fenétre en cliquant sur [X] par erreur,
mettez le systeme hors tension avant de le remettre sous tension.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant le
document que vous souhaitez archiver.

| (¢ Electronic Filing
Edit  View o BEHS &

Document {8 e-Filing (8 items)
F3 e-Filing

Mg Public Box

g1 001 UserBox01
571 002 UserBox02 63 %
571003 UsarBox03 &

13 004 UserBox04
f1 005 UserBox03
g1 006 UserBox06
& 5@ 007 UserBox07 Cpublic Box [Joo1 userBoxo1
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2 Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

3 Cochez la case du document a archiver et sélectionnez [Fichier (File)] > [Archiver document
(Archive Document)].

| (¢ Electronic Filing

Document

1B e-Filing
[ Public Box
= é’? 001 UserBox01
(] Foldero1
E DOCO051016
EDOCU51016-UU Properies
Gl 002 UserBox02
5] 003 UserBox03
&) 004 UserBox04
&) 005 UserBox05 —_
57 006 UserBox06 [Foldero1
57 007 UserBox07

DOCD51016
[Scan]

|
M |

La boite de dialogue de confirmation apparait.

Remarque

Les utilisateurs peuvent également archiver un document en le sélectionnant dans le volet Document, puis
[Fichier (File)] > [Archiver document (Archive Document)]. Toutefois, vous ne pouvez pas archiver de pages
individuelles méme en activant leurs cases a cocher dans le volet Contenu.

4 Cliquez sur [OK] pour lancer le processus d'archivage.

This site says...

Do you want to archive the document?
This process may take some time.

)

5 La fenétre Archiver document apparait. Pendant l'archivage, vous pouvez quitter le processus en
cliquant sur [Annuler (Cancel)].

Archive Document

This process may take some time.
Please wait while the document is compressed and a downloadable archive file is created.

1%
I

Cancel

Lorsque l'archivage du document est terminé, le message "Le document a été archivé" apparait.

Remarque

Si l'utilitaire Web e-Filing est en train d'effectuer une tache, attendez qu'il ait fini.
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6 Cliquez sur le lien du nom du fichier pour télécharger le fichier archivé.

Archive Document

‘Your document has been archived successfully

Please click the link below.

You can now download the archived file onto your system

The link will launch a file download dialog allowing you fo select a name and path for the zip file.
File Name : E-FilingArchive.zip

Created:  05.10.2016 10:20:22
Size (KB): 1519 KB

Les fichiers sont enregistrés dans un dossier défini par votre navigateur.

7 Cliquez sur [Fermer (Close)].

Archive Document
‘Your document has been archived successfully

Please click the link below.

You can now download the archived file onto your system

The link will launch a file download dialog allowing you to select a name and path for the zip file.
File Name : E-FilingArchive.zip

Created : 05.10.2016 10:35:01

Size (KB): 2512 KB

A

O Chargement des documents archivés

Sivous avez téléchargé sur votre ordinateur depuis le systeme un fichier archivé, vous pouvez le charger dans un
répertoire e-Filing. Lorsque vous chargez le fichier archivé, celui-ci est automatiquement extrait et les documents
sont créés dans le répertoire spécifié.

Remarque

* Siun document du méme nom existe déja dans le répertoire, le document extrait sera renommé avec 3 chiffres
ajoutés au nom d'origine.

* Ne fermez pas la fenétre principale ni la fenétre enfant en cliquant sur le bouton [X]. Cette opération rendrait en
effet impossible le téléchargement des documents archivés. Sivous fermez la fenétre en cliquant sur [X] par erreur,
mettez le systéme hors tension avant de le remettre sous tension.

Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier dans lequel
vous souhaitez charger les documents archivés.

| (¢ Electronic Filing

Document {8 e-Filing (8 items)
F3 e-Filing
=+ [-f] Public Box
g1 001 UserBox01
571 002 UserBox02 63 %
571003 UsarBox03 &
Lj 004 UserBox04
005 UserBox05
006 UserBox06

& 5@ 007 UserBox07 Cpublic Box Cloo1 userBoxo1

2 Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].
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3 Sélectionnez [Fichier (File) > [Charger un document archivé (Upload Archived Document)].

| (¢ Electronic Filing

Document

{f e-Filing
[7) Public Bax
ga 001 UserBox01
El 7 002 UserBox02
=] Folder02
&7 003 UserBox03
&p) 004 UserBox04
&p 005 UserBox05
&7 006 UserBox06
&7 007 UserBox07
CIFoldero2

La fenétre Charger un document archivé apparait.

4 Cliquez sur [Parcourir (Browse)].

Upload Archived Document

Archived File :

Browse...

A

La boite de dialogue [Choisir le fichier a charger (Choose File to Upload)] apparait.

5 Sélectionnez un fichier archivé a télécharger et cliquez sur [Ouvrir (Open)].

Open

« v P ‘ » ThisPC » Downloads »> v O Search Downloads

Organise »  New folder

7 Quick access ¥

§ E-FilingArchive.zip %
i

¢@ OneDrive

[ This PC
[ Desktop
@ Decuments
-4 Downloads
D Music
&=| Pictures
B videos
e Local Disk (C)

£F Network

E Photos

| [anites )

File name: | E-FilingArchive.zip

[F-]m @

x

p

v2

Vous retournez alors a la fenétre de chargement du document archivé et le chemin du dossier du fichier

sélectionné apparait dans la case "Fichier archivé".

6 Cliquez sur [OK].

Upload Archived Document

Archived File : C:\Users\[ '® § s Bsw\Dd Browse.

A
A\

La boite de dialogue de confirmation apparait.

7 Cliquez sur [OK] pour lancer le chargement du fichier archivé.

This site says...

Do you want to upload the archived file?
This process may take some time.
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Remarque

Sivous sélectionnez un fichier archivé non pris en charge dans votre modele ou un fichier non archivé, un
message d'erreur s'affiche. Dans ce cas, sélectionnez le bon fichier archivé et réessayez.

8 La fenétre Charger un document archivé montre le processus de chargement. Vous pouvez
quitter a tout moment le processus de chargement en cliquant sur [Annuler (Close)].

Upload Archived Document
This process may take some time.
Please wait while the archived file is uploaded fo the selected box.

1%
I

Lorsque le chargement du document est terminé, un message vous informe que le document a été chargé.

Remarque

Si l'utilitaire Web e-Filing est en train d'effectuer une tache, attendez qu'il ait fini.

9 Cliquez sur [Fermer (Close)].

Upload Archived Document

Your document has been uploaded successfully.

Les documents sont ajoutés dans le répertoire sélectionné.

M Envoi d'un message électronique

Vous pouvez envoyer par messagerie électronique des documents depuis 'utilitaire Web e-Filing.
Lorsque vous exécutez cette fonction, le systéme crée un message électronique a l'aide des documents sélectionnés
sous forme de fichier joint et il envoie le message électronique directement a partir du systéme.

Pour utiliser cette fonctionnalité, la fonction de numérisation est requise.

Remarque

* Pour que la commande Envoyer un E-mail soit disponible, l'administrateur réseau doit correctement définir les
parameétres de messagerie du systeme.

* Lorsque vous utilisez un systéme numérique couleur multifonctions (couleur MFP), vous pouvez envoyer des
documents e-Filing sous forme de messages électroniques uniquement s'ils ont été enregistrés en respectant les
conditions ci-dessous. Vérifiez les propriétés des documents avant de les envoyer.

- Le document a été enregistré a l'aide de la fonction de copie du systéme et en noir et blanc.
- Le document a été enregistré a l'aide de la fonction de numérisation du systéme.
- Le document a été enregistré a l'aide de la fonction de transfert de fax/fax Internet regus.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant le
document que vous souhaitez envoyer par e-mail.

| () Electronic Filing

Document {8 e-Filing (8 items)
B a-FEilina

* [ Public Box
=] 001 UserBox01
002 UserBox02 Ea Ka
5@ 003 UserBox03 ﬂ
5@ 004 UserBox04
@ 005 UserBox05
& 006 UserBox06
@ 571007 UserBox07 Cpublic Box Coo1 useroxo1
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2

3

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification

par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de

passe de la boite (Box Password)].

Cochez la case du document a envoyer par e-mail et sélectionnez [Fichier (File) > [Envoyer un

e-mail (Send Email)].

| (¢ Electronic Filing

Document

{f e-Filing
[7) Public Bax
El 7 001 UserBox01 Upload Archived Document
(-] Foldero1 Test Pri
[& DoCo51016 Print Document
E DOC051016-00 [r—
&p 002 UserBox02
=] 003 UserBox03
=] 004 UserBox04
2} 005 UserBox05
e} 006 UserBox06
&) 007 UserBox07

[ Feldero1 z
DOC051016
[Scan]

Al |
La page Envoyer un E-mail apparait.

Conseil

* Les utilisateurs peuvent également envoyer un document par e-mail en le sélectionnant dans le volet

Document, puis [Fichier (File)] > [Archiver document (Archive Document)].

* Les utilisateurs peuvent également envoyer jusqu'a 100 pages ou documents en activant les cases a cocher

appropriées dans le volet Contenu.
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4 Paramétrez les éléments suivants comme il convient, puis cliquez sur [Envoyer (Send)].

Send Email
TO: Destination Setting
|TO! Destination I |
CC: Destination Setting
[CC: estination I |
BCC: Destination Setting
| BCC: Destination [ |
Email Setting
*Required
(®) Send data from (Device name} (Box Info.)
Subject o]
Add the date and time to the subject
*From Address 192.168.0_10@ttec-mfol 1 net
From Name user001] x
Body
File Format PDF(Multi) |
[] Eneryption
Master Passviord [ Retype assvord [N
Encryption Level | 128-bit AES
ErETE Authority
Printing
Change of Documents
Content Copying or Extraction
Content Exiraction for accessibility
(® DOCYYMMDD(YYMMDD is a date)
File Name: (O Original Document Name
Fragment Message Size No Fragmentation ~

4\
[Paramétrage de la destination A : (TO: Destination Setting)] — Cliquez sur ce bouton pour indiquer la
destination. La liste des destinataires apparait. Pour plus d'informations sur la spécification de la destination,
reportez-vous a la section suivante :
P.70 "Paramétrage de la destination"
[Paramétrage de la destination CC : (CC: Destination Setting)] — Cliquez sur ce bouton pour indiquer la
destination CC.
[Paramétrage de la destination BCC : (BCC: Destination Setting)] — Cliquez sur ce bouton pour indiquer la
destination BCC.
Objet — Ce champ définit I'objet des documents du message électronique. Sélectionnez |'option [Envoyer les
données depuis (nom du périphérique) (infos de liste.) (Send data from (Device name) (Box Info.)] définie par
défaut ou saisissez l'objet souhaité dans la liste. Pour ajouter la date et 'heure a |'objet du message, activez la
case a cocher [Ajouter la date et ['heure a ['objet (Add the date and time to the subject)].
De — Saisissez |'adresse électronique de |'expéditeur. Lorsque le destinataire répond, son message est envoyé a
cette adresse électronique.
Depuis le nom — Saisissez le nom de |'expéditeur du message électronique.
Corps — Saisissez le corps du message en veillant a ne pas dépasser 1000 caractéres (espaces inclus).
Format de fichier — Sélectionnez le format de fichier dans lequel sera converti le document recu.

* TIFF (Multi) — Sélectionnez cette option pour enregistrer les images numérisées au format TIFF multipage.

* TIFF (Simple) — Sélectionnez cette option pour enregistrer les images numérisées séparément au format TIFF
simple.

* PDF (Multi) — Sélectionnez cette option pour enregistrer les images numérisées au format PDF multipage.

¢ PDF (Simple) — Sélectionnez cette option pour enregistrer les images numérisées séparément au format PDF
simple.

¢ XPS (Multi) — Sélectionnez cette option pour enregistrer les images numérisées au format XPS multipage.

¢ XPS (Simple) — Sélectionnez cette option pour enregistrer les images numérisées séparément au format XPS
simple.

* JPEG — Sélectionnez cette option pour enregistrer les images numérisées au format JPEG. Cette option est
disponible uniquement si les images ont été numérisées en mode [Couleurs (Full Color)] ou [Niv.gris (Gray
Scale)].

Cryptage : activez cette option pour crypter les fichiers PDF si vous avez sélectionné le format de fichier "PDF
(Multi)" ou "PDF (Simple)".
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¢ Cryptage — Activez cette case a cocher pour crypter les fichiers PDF.
¢ Mot de passe utilisateur — Saisissez le mot de passe requis pour ouvrir le fichier PDF crypté.

* Mot de passe master — Saisissez le mot de passe requis pour modifier le paramétre de cryptage PDF.
* Niveau de cryptage — Sélectionnez le niveau de cryptage souhaité.
- RC4 a 40 bits — Sélectionnez cette option pour appliquer un niveau de cryptage compatible avec Acrobat

3.0, PDF V1.1,

- RC4 a 128 bits — Sélectionnez cette option pour appliquer un niveau de cryptage compatible avec Acrobat
5.0, PDF V1.4.

- AES a 128 bits — Sélectionnez cette option pour appliquer un niveau de cryptage compatible avec Acrobat
7.0, PDF V1.6.

¢ Droit — Sélectionnez le type de droit désiré sur les fichiers PDF cryptés.
- Impression

- Modification des documents
- Copie ou extraction de contenu

- Extraction de contenu pour accessibilité
Nom du fichier : spécifiez le type de dénomination du fichier joint.
Fragmenter le message — Sélectionnez la taille de fragmentation des messages.
Code départemental — Saisissez le code départemental, si nécessaire.
Code projet : saisissez un code projet, si besoin.

Remarque

* Silafonction de cryptage forcé est activée, seules les options [PDF (Multi)] et [PDF (Simple) (PDF (Single)] sont
disponibles. Pour plus d'informations sur la fonction de cryptage forcé, reportez-vous au Guide
d'administration.

* Les fichiers enregistrés au format XPS peuvent étre utilisés sous Vista ou version ultérieure et
Windows Server 2008 ou version ultérieure a condition que .NET Framework 3.0 soit installé.

* Seuls les utilisateurs autorisés peuvent modifier ces mots de passe. Les utilisateurs ne peuvent pas modifier
les parametres des champs [Niveau de cryptage (Encryption Level)] et [Droit (Authority)] ci-dessous s'ils ne
sont pas autorisés a modifier le mot de passe master. Pour redéfinir ces mots de passe, contactez votre
administrateur. Pour plus d'informations sur la fonction de cryptage, reportez-vous au Guide
d'administration.

Conseil

* Silafonction de cryptage forcé est activée, vous ne pouvez pas désactiver la case a cocher [Cryptage
(Encryption)]. Pour plus d'informations sur la fonction de cryptage forcé, reportez-vous au Guide
d'administration.

* Les mots de passe utilisateur et master ne sont pas définis en usine. Si le mot de passe master doit étre défini,
consultez votre administrateur réseau.

* Pour les mots de passe, vous devez saisir des caractéres alphanumériques codés sur un octet en veillant a ne
pas dépasser la limite autorisée, soit 32 caracteres.

* Les mots de passe utilisateur et master doivent étre différents.

Cliquez sur [Fermer (Close)].

| (¢ Electronic Filing |

Send Email

Your document has been sent successfully.
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O Paramétrage de la destination

La page Liste des destinataires permet de définir les destinations vers lesquelles les documents e-Filing seront
envoyés par e-mail.

Pour définir les destinataires, vous pouvez saisir leur adresse électronique, les sélectionner dans le carnet d'adresses,
sélectionner des groupes de destinataires dans le carnet d'adresses ou les rechercher sur le serveur LDAP.

Conseil

La page Liste des destinataires permet de définir jusqu'a 400 destinations.

Remarque

Si vous avez sélectionné ['option [Authentification LDAP (LDAP Authentication)] pour [Type d'authentification
(Authentication Type)], vous pouvez choisir uniquement des destinations enregistrées sur les serveurs LDAP
authentifiés. Pour plus d'informations sur ['option Authentification LDAP, reportez-vous au Guide de TopAccess.

P.70 "Saisie des destinataires"

P.71 "Sélection des destinataires dans le répertoire téléphonique"
P.72 "Sélection de groupes depuis un répertoire téléphonique"
P.73 "Recherche de destinataires sur le serveur LDAP"

P.74 "Suppression des contacts de la liste des destinataires"

Saisie des destinataires
Suivez les étapes décrites ci-apres pour ajouter manuellement un destinataire a la liste des destinataires.

1 Cliquez sur [Configurer la destination (Destination Setting)] pour accéder a la page Liste des
destinataires.

2 Cliquez sur [Nouvelle (New)].

Recipient List

| Cancel ‘l Address Book || Address Group H Search | Delete
|L||VM l’\? Destination

La page Propriétés du contact apparait.

3 Saisissez l'adresse e-mail du destinataire, puis appuyez sur [OK].

Contact Property
(0K { Gancel | Roset

“RequAY =
“Destinatio ”UserUDZ@example com|

W1

Le nouveau destinataire est ajouté a la liste des destinataires.

4 Répétez les étapes 2 et 3 pour ajouter autant de destinataires que nécessaire.

Conseil

Vous pouvez supprimer les contacts ajoutés a la liste des destinataires avant d'enregistrer les paramétres de
destination.
P.74 "Suppression des contacts de la liste des destinataires"

5 Cliquez sur [Enregistrer (Save)].

Recipient List

| Cancel ‘| Address Book || Address Group H Search || Delete ‘
[T [9A)ne

Desiination

0 User002@example.com

Les contacts sont ajoutés comme destinations.
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Sélection des destinataires dans le répertoire téléphonique

Suivez la procédure ci-dessous pour sélectionner les destinataires dans le répertoire téléphonique.

1
2

Cliquez sur [Configurer la destination (Destination Setting)] pour accéder a la page Liste des

destinataires.

Cliquez sur [Carnet d'adresses (Address Book)].

Recipient List

| Cancel “ Address Boukh“ Address Group H Search | Delete
|

|i||vm

|Desﬁnaﬁm

La page Répertoire téléphonique apparait.

Dans la colonne E-mail, activez les cases a cocher des utilisateurs que vous voulez ajouter et

cliquez sur [Ajouter (Add)].

Address Book

ULl Favorile Address Book

Group [All Groups

-

== Previous Page =< 1> Next Page >»

]

]

=
=
=
=
El
El

=]

Email [wName

Email Address

Favorite

{User 010

User_010@sxample.com

User 009

User_009@example com

User 008

User_003@example.com

User 007

User_007 @example.com

User 006

User_006@example.com

User 005

User_005@sxample com

User 004

User_004@example.com

User 003

User_0o3@sxample.com

User 002

User_002@example.com

‘User001

User_001@example.com

Les destinataires sélectionnés sont ajoutés a la page Liste des destinataires.

Conseil

* Sivous voulez trier les destinataires dans des groupes spécifiques, sélectionnez le nom du groupe souhaité
dans la case [Groupe (Group)].
* Vous pouvez supprimer les contacts ajoutés a la liste des destinataires avant d'enregistrer les paramétres de

destination.
P.74 "Suppression des contacts de la liste des destinataires"

Cliquez sur [Enregistrer (Save)].

< |

Recipient List

we | Cancel ‘l Address Book || Address Group H Search || Delete ‘

S\l

Destination

User 004

User_DD4@example.com

User 003

User_0D3@example com

]
]
m|

User 002

User_002@example.com

Les contacts sont ajoutés comme destinations.
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Sélection de groupes depuis un répertoire téléphonique
Suivez la procédure ci-dessous pour sélectionner les groupes dans le répertoire téléphonique.

1 Cliquez sur [Configurer la destination (Destination Setting)] pour accéder a la page Liste des
destinataires.

2 Cliquez sur [Adresse du groupe (Address Group)].

Recipient List

| Cancel ‘l Address Book || Address Group.H Search | Delete
|
|i||vName Destination Vw

La page Adresse du groupe apparait.

3 Activez les cases a cocher des groupes contenant les destinataires souhaités et cliquez sur
[Ajouter (Add)].

Address Group

EULIEERRElO  Favorite Address Group

am:el

IG-roup wGroup Name Favorite
[] V| Groupbos
[] | Group0od
[] | Group0o3
GroupD01

Gu top of this page

Tous les destinataires des groupes sélectionnés sont ajoutés dans la page Liste des destinataires.

Conseil

Vous pouvez supprimer les contacts ajoutés a la liste des destinataires avant d'enregistrer les paramétres de
destination.
P.74 "Suppression des contacts de la liste des destinataires"

4 Cliquez sur [Enregistrer (Save)].

Recipient List

| Cancel ‘l Address Book || Address Group H Search || Delete ‘
[ [¥ne

Destination

[] | Groupoot Group

Les contacts sont ajoutés comme destinations.
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Recherche de destinataires sur le serveur LDAP
Suivez la procédure ci-apres pour rechercher des destinataires sur le serveur LDAP.

Conselil

Pour rechercher des destinataires dans le serveur LDAP, un administrateur doit configurer le service d'annuaire en
utilisant TopAccess en mode d'administration. Pour plus d'informations, reportez-vous au Guide de TopAccess.

1 Cliquez sur [Configurer la destination (Destination Setting)] pour accéder a la page Liste des

destinataires.

2 Cliquez sur [Rechercher (Search)].

Recipient List

| Cancel ‘l Address Book || Address Group H Seamh.l Delete
|

|i| |VM |Destinaliﬂn W

La page Rechercher un contact apparait.

3 Spécifiez une condition de recherche, puis cliquez sur [Rechercher (Search)].
Sélectionnez le nom du service d'annuaire a rechercher dans la boite [Nom du service d'annuaire (Directory

Service Name)], puis saisissez les termes recherchés dans les champs appropriés.

Search Contact

Enter a p: k BAE or Email address to search for a contact.

Direclory Service Name |LDAPO1 v
First Name User| &' *

Last Name 1

Email Address

Company

\
\
Fax Number ‘
\
\

Department

TopAccess commence la recherche des destinataires sur le serveur LDAP et la page Rechercher la liste des

adresses affiche les résultats.

Conseil

* Sivous sélectionnez le nom de votre systéme dans la liste déroulante [Nom du service d'annuaire (Directory
Service Name)], la recherche s'effectuera dans le répertoire téléphonique du systéme.
* TopAccess va rechercher les destinataires correspondant aux informations que vous avez saisies.

* Renseignez au moins un champ pour lancer une recherche approximative.
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Dans la colonne E-mail, activez les cases a cocher des utilisateurs que vous voulez ajouter et
cliquez sur [Ajouter (Add)].

Search Address List

q-\dd Cancel

Number of Search Resuit:30

Emsil |wName Email Address

(] Jser 030 User_030@example com
O ser 029 User_029@example com
O ser 028 User_025@sxample com
[l ser 027 User_027 @example com
[l ser 026 User_026@example com
[l ser 025 User_025@example com
ser 024 User_024@example com
ser 023 User_023@example com
ser 022 User_022@example com
O ser 021 User_021@example com
[ ser 020 User_020@example.com
[ ser 019 User_019@example.com
[l ser 012 User_018@example.com
[l ser 017 User_017@example.com
[ g 0serots User_016@example com

Les destinataires sélectionnés sont ajoutés a la page Liste des destinataires.

Conseil

Vous pouvez supprimer les contacts ajoutés a la liste des destinataires avant d'enregistrer les paramétres de
destination.

P.74 "Suppression des contacts de la liste des destinataires"

5 Cliquez sur [Enregistrer (Save)].

Recipient List

Sava; | Cancel ‘l Address Book || Address Group H Search || Delete ‘
| [ Destination

[] |user 024 User_024@example.com

[]|useroz3 User_023@example.com

[ |useroz22 User_022@example. com

Les contacts sont ajoutés comme destinations.

Suppression des contacts de la liste des destinataires

1 Activez les cases des contacts a supprimer de la liste des destinataires et cliquez sur [Effacer
(Delete)].

Recipient List

| Cancel ‘l Address Book || Address Group H Search || Delme\
]

Destination “\

User_024@example.com

User_D23@example.com

User_022@example com

Les contacts sélectionnés sont supprimés de la liste des destinataires.
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Edition des pages de vos documents

L'utilitaire Web e-Filing permet de modifier les documents stockés avant de les imprimer.

Il comporte trois boutons de commande : [Modifier (Edit)], [Enregistrer (Save)] et [Annuler (Cancel)].

Ces boutons s'affichent en haut du volet Contenu lorsque vous sélectionnez un document dans le volet Document.
Les boutons affichés varient en fonction de |'état du document.

¢ [Modifier (Edit)] — Cliquez sur ce bouton pour modifier le document. Ce bouton apparait uniquement en mode
d'affichage, lorsque |'état du document indique "Affichage". Lorsque vous cliquez sur [Modifier (Edit)], |'état du
document devient "Modifier", les boutons [Enregistrer (Save)] et [Annuler (Cancel)] se substituent au bouton
[Modifier (Edit)] et vous pouvez modifier le document. Si vous cliquez sur ce bouton alors que |'état du document
est "En cours d'utilisation", vous ne pouvez pas passer en mode d'édition et le message "Le document est en cours
d'utilisation. Recommencez plus tard" apparait.

* [Enregistrer (Save)] — Cliquez sur ce bouton pour enregistrer le document que vous avez modifié. Ce bouton est
uniquement visible en mode d'édition, lorsque |'état du document est "Modification". Lorsque vous cliquez sur ce
bouton, le document est enregistré et le mode d'affichage est rétabli.

* [Annuler (Cancel)] — Cliquez sur ce bouton pour revenir en mode d'affichage sans enregistrer le document. Ce
bouton est uniquement visible en mode d'édition, lorsque |'état du document est "Modification".

L'état du document est indiqué a gauche de ces boutons. Les différents états sont :

* En cours d'utilisation — Indique que le document est en cours de modification par un autre utilisateur.

* Affichage — Indique que le document est en mode d'affichage. Celui-ci ne permet que de visualiser les pages du
document.

* Modification — Indique que vous pouvez modifier le document.

Remarque

Lorsque vous modifiez ou supprimez un document que vous partagez avec d'autres utilisateurs, n'oubliez pas de
rafraichir l'affichage pour voir 'état réel du document. Si plusieurs utilisateurs modifient ou suppriment
simultanément le document et ses pages, certaines données risquent d'étre endommagées.

L'utilitaire Web e-Filing permet de copier, de déplacer, de supprimer et d'insérer des pages dans les documents, ainsi
que d'en modifier l'ordre.

P.76 "Affichage des propriétés des documents et des pages"

P.77 "Copie de pages d'un document a un autre"

P.82 "Copie des pages d'un document dans une boite ou un dossier"

P.85 "Suppression de pages dans un document"

P.87 "Insertion d'une page vierge dans un document"

P.90 "Déplacement de pages dans un document"
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M Affichage des propriétés des documents et des pages

Vous pouvez afficher les fenétres des propriétés du document et de la page pour en connaitre le détail. Pour afficher la
fenétre des propriétés d'un document, activez la case a cocher de ce document et sélectionnez [Propriétés
(Properties)] dans le menu [Fichier (File)]. Pour afficher la fenétre des propriétés d'une page, activez la case a cocher
de la page et sélectionnez [Propriétés (Properties)] dans le menu [Fichier (File)].

La fenétre des propriétés du document contient les informations suivantes :

Document Properties

I_—\f DOC051016-001
Location e-Filing/UserBox01/
Total Page(s) 3

Size 1190 KB

Created - 05.10.2016 09:28:38
Modified 05.10.2016 09:28:38
Last Accessed 05.10.2016 10:35:01

* Emplacement
Affiche le dossier dans lequel se trouve le document.
* Total page(s)
Affiche le nombre de pages du document.
* Format
Affiche la taille des données du document.
e Crééle
Affiche la date et I'heure de création du document.
* Modifié(e)
Affiche la date et I'heure de la derniére modification du document.
 Dernier acces
Affiche la date et I'heure auxquelles le document a été ouvert pour la derniére fois.
* [OK]
Cliquez sur ce bouton pour fermer la fenétre.

La fenétre des propriétés de la page contient les informations suivantes :

Page Properties

I_—lf DOC051016-001 (1/3)

Format Scan
Resolution 200 % 200
Image Size 1646 % 2331
Paper Size A4

Size : 306 KB

* Format
Affiche le mode dans lequel la page a été enregistrée.
* Résolution
Affiche la résolution de la page.
* Formatdel'image
Affiche la taille en pixels de la page.
* Format papier
Affiche le format de papier de la page.
* Format
Affiche la taille des données de la page.
* [OK]
Cliquez sur ce bouton pour fermer la fenétre.
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B Copie de pages d'un document a un autre

Vous pouvez copier ou couper des pages d'un document et les insérer dans un autre.

1

2

Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant le
document dont vous souhaitez copier ou couper des pages.

Document

@ e-Filina

= (°f Public Box

éa 001 UserBox01
&l 002 UserBox02
&) 003 UserBox03
&) 004 UserBox04
&g 005 UserBox05
&) 006 UserBox06
# 25 007 UserBox07

{E eFiling (8 items)

| (@ Electronic Filing |

7]

[Jpublic Box

[Joo1 usersoxo1

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion estimpossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

Dans le volet Document, sélectionnez le document dont vous souhaitez copier ou couper des

pages.

Electronic Filing

L

Document

g e-Filing
[g] Public Box

El $ 001 UserBox01
[£] Folder01
[& DOCO51016

[& DOC051016-00

&l 002 UserBox02
&l 003 UserBox03
&7 004 UserBox04
&F1 005 UserBox05
&1 006 UserBox06
&) 007 UserBox07

<Y

[ DOCO051016-001 (1/3)

D
|/

DPages 1

DPages 2

DPages 3

Login

Documents Preferences

Status : View

Les pages du document apparaissent dans le volet Contenu.

Conseil

Si vous souhaitez couper des pages du document, cliquez sur [Modifier (Edit)] pour passer en mode d'édition. En
cliquant sur [Modifier (Edit)], vous faites passer le document du mode d'affichage au mode d'édition et vous

pouvez ainsi couper des pages du document.

Remarque

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant
donné qu'un autre utilisateur travaille actuellement sur ce document.
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Cochez les pages que vous souhaitez copier ou couper, puis sélectionnez [Modifier (Edit)] >
[Copier (Copy)] ou [Couper (Cut)].

| (¢ Electronic Filing

Document
4B e-Filing
[y Public Box
a % 001 UserBox01
(~) Folder01
% DOC051016
DOC051016-00
&p) 002 UserBox02
&) 003 UserBox03
&pl 004 UserBox04
5 005 UserBox05 [Ipages 1
&F 006 UserBox06
&F 007 UserBox07

Documents | Preferences
Save | | Cancel

Login

Status : Editing

Pages 2

* Sivous choisissez de couper des pages, passez a |'étape suivante a la fin de votre opération.

¢ Sivous choisissez de copier des pages, passez a |'étape 7 a la fin de votre opération.

Remarque

Si l'utilitaire Web e-Filing est en train d'effectuer une tache, attendez qu'il ait fini.

5 Cliquez sur [Enregistrer (Save)].

|®Efecrmnic Filing Loain

Document & DOC051016-001 (1/1) Status : Editing

4B e-Filing ——
[y Public Box
=] % 001 UserBox01

) Foldero1 ﬂ] ™
& DOC051016 J =
DOC051016-00] /

&p) 002 UserBox02
&) 003 UserBox03
&l 004 UserBox04
5 005 UserBox05 [Jrages 1
Eﬁ 006 UserBox06
Eﬁ 007 UserBox07 2 items are cut.

La fenétre d'enregistrement du document apparait.

6 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

Save

’
Document Name | [DOC051016-001 x
S

* Sivous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son
nom, le document sera écrasé.

* Le document passe du mode d'édition au mode d'affichage.

Remarque

Ne fermez pas la fenétre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de
provoquer un dysfonctionnement du systeme. Si vous fermez la fenétre en cliquant sur [X] par erreur, mettez le
systéme hors tension avant de le remettre sous tension.
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7

8

Dans le volet Document, sélectionnez le répertoire ou le dossier contenant le document dans
lequel vous souhaitez insérer les pages copiées.

Electronic Filing

L i

Document
{FgFiling
¥l f Public Box
=] % 001 UserBox01
(~) Folder01
% DOC051016

% DOC051016-00

&p) 002 UserBox02
&) 003 UserBox03
&pl 004 UserBox04
&pl 005 UserBox05
&F 006 UserBox06
&F 007 UserBox07

[ DOCO051016-001 (1/1)

LAY :

DPEQGS 1

The Document is saved.

Documents Preferences Login

Status : View

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

Dans le volet Document, sélectionnez le document dans lequel vous souhaitez insérer les pages

copiées, puis cliquez sur [Modifier (Edit)].

Electronic Filing

L i

Document
& e-Filing
[y Public Box
El % 001 UserBox01
0] Folder01
E DOC160510

DOC160510-00

£ 5 002 UserBox02
= &5 Folder02

E DOC160510-00

&Fl 003 UserBox03
gl 004 UserBox04
gl 005 UserBox05
&F 006 UserBox06
ga 007 UserBox07

[ DOC160510-001 (1/3)

DPages 1

DPages 2

O Pages 3

Les pages du document apparaissent dans le volet Contenu et le document passe du mode d'affichage au mode

d'édition.

Remarque

Sil'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant
donné qu'un autre utilisateur travaille actuellement sur ce document.
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10 Cliquez sur l'espace entre les pages ou vous souhaitez insérer les pages copiées.

| (@ Electronic Filing

Document

iy e-Filing
[fl Public Box
=] @ 001 UserBox01
(=) Folder01
% DOC160510
DOC160510-00
£ 7 002 UserBox02
= 5 Folder02
DOC160510-00
&l 003 UserBox03
&) 004 UserBox04
&g 005 UserBox05
&l 006 UserBox06
ga 007 UserBox07

A

DPages 1

O Pages 2

Documents

Status : Editing

Preferences

Login

O Pages 3

Les indicateurs de direction se déplacent alors vers |'espace sur lequel vous avez cliqué.

11 Sélectionnez [Modifier (Edit)] > [Coller (Paste)].

| (@ Electronic Filing

Document

e-Filin
Filing
[f) Public Box
=] % 001 UserBox01
] Folder01
E DOC160510
DOC160510-00
= % 002 UserBox02
[ 3 Folderao2
DOC160510-00
&g 003 UserBox03
& 004 UserBox04
& 005 UserBox05
&g 006 UserBox06
Ea 007 UserBox07

|:|Pages 1

|:|Pages 2

Documents Preferences

Login

Status : Editing

|:|Pages 3

Les pages copiées sont insérées entre les pages spécifiées.

12 Cliquez sur [Enregistrer (Save)].

Documents Preferences

Login

| (¢ Electronic Filing

Document

{f e-Filing
[g) Public Box
El é’? 001 UserBox01
(7] Folder0o1
% DOC160510
DOC160510-00
£ 4 002 UserBox02
= &5 Folder02
DOC160510-00
&p) 003 UserBox03
&g 004 UserBox04
&5 005 UserBox05
&F 006 UserBox06
Ea 007 UserBox07

Status : Editing

|:|Pages 5

DPages 2

O Pages 3

O Pages 4

La fenétre d'enregistrement du document apparait.
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13 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

Save

Document Name|| [DOC160510-001

¢ Sivous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son g
nom, le document sera écrasé.

¢ Le document passe du mode d'édition au mode d'affichage.

Remarque

Ne fermez pas la fenétre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de
provoquer un dysfonctionnement du systéme. Si vous fermez la fenétre en cliquant sur [X] par erreur, mettez le
systéme hors tension avant de le remettre sous tension.
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l Copie des pages d'un document dans une boite ou un dossier

Vous pouvez copier ou couper des pages d'un document et les enregistrer dans une boite ou un dossier en tant que
nouveau document.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant le
document dont vous souhaitez copier ou couper des pages.

| (¢ Electronic Filing |

Document & e-Filing (3items)
@ e-Filina
| [ Public Box
ga 001 UserBox01
4 002 UserBox02 @
571002 UserBox03
&7 004 UserBox04
&) 005 UserBox05
&) 006 UserBox06
[ f 007 UserBox07 Opublic Box ooz usergoxo1

2 Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

3 Dans le volet Document, sélectionnez le document dont vous souhaitez copier ou couper des
pages.

|@Efecrmnfc Filing Login

Document [ DOC160510-001 (1/3) Status : View
g e-Filing
[7 Public Box
=] % 001 UserBox01 ]
] Folder01
E DOC160510
E DOC160510-00

& 002 UserBox02 k L \ﬂ4 )

&g 003 UserBox03
&7 004 UserBox04
&7 005 UserBox05
&F 006 UserBox06
&p) 007 UserBox07 [pages 1 [Jpages 2 [rages 3

Les pages du document apparaissent dans le volet Contenu.

Conseil

Si vous souhaitez couper des pages du document, cliquez sur [Modifier (Edit)] pour passer en mode d'édition. En
cliquant sur [Modifier (Edit)], vous faites passer le document du mode d'affichage au mode d'édition et vous
pouvez ainsi couper des pages du document.

Remarque

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant
donné qu'un autre utilisateur travaille actuellement sur ce document.
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Cochez les pages que vous souhaitez copier ou couper, puis sélectionnez [Modifier (Edit)] >
[Copier (Copy)] ou [Couper (Cut)].

| (¢ Electronic Filing

Document
4B e-Filing
[g) Public Box
=] éﬁ 001 UserBox01
(-] Folder0o1l
% DOC160510
DOC160510-00
&5 002 UserBox02
&5 003 UserBox03
&7 004 UserBox04

&F 005 UserBox05 M pages 1 [prages 2 [rages 3
&p) 006 UserBox06
&p) 007 UserBox07 1

* Sivous choisissez de couper des pages, passez a |'étape suivante a la fin de votre opération.

Documents Preferences

Loqgin

Status : Editing

¢ Sivous choisissez de copier des pages, passez a |'étape 7 a la fin de votre opération.

Remarque

Si l'utilitaire Web e-Filing est en train d'effectuer une tache, attendez qu'il ait fini.

Cliquez sur [Enregistrer (Save)].

|®Efecrmnfc Filing Login

Document Status : Editing

e-Filin,
g
[g) Public Box
= 6’? 001 UserBox01
=] Feldero1l
E DOC160510
DOC160510-00
50 002 UserBox02
57 003 UserBox03
&7 004 UserBox04
ﬁﬁ 005 UserBox05 O Pages 1 O Pages 2
) 006 UserBox06
&g 007 UserBox07 1 item is cut.

La fenétre d'enregistrement du document apparait.

Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

Save

Document Name ﬂ)O(ﬂSDSW 0-001
W

* Sivous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son
nom, le document sera écrasé.

¢ Le document passe du mode d'édition au mode d'affichage.

Remarque

Ne fermez pas la fenétre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de
provoquer un dysfonctionnement du systéme. Si vous fermez la fenétre en cliquant sur [X] par erreur, mettez le
systéme hors tension avant de le remettre sous tension.
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7 Dans le volet Document, sélectionnez le répertoire ou le dossier dans lequel vous souhaitez
stocker les pages copiées.

Login
Status : View

(¢ Electronic Filing

=] éﬁ 001 UserBox01
(-] Folder0o1l
% DOC160510
% DOC160510-00
&5 002 UserBox02
&5 003 UserBox03
&7 004 UserBox04
&F 005 UserBox05
&p) 006 UserBox06
&p) 007 UserBox07

O Pages 1 O Pages 2

The Document is saved.

8 Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un accés non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

9 Sélectionnez [Modifier (Edit)] > [Coller (Paste)].

| (@ Electronic Filing

Document

B e-Filing
(7 Public Box
= éﬁ 001 UserBox01
=] Foldero1
[& DOC160510
[& DOC160510-00
=] é’? 002 UserBox02
(-] Folder02
[ DOC160510-00
&g 003 UserBox03
571 004 UserBox04 [CJFoldero2
571 005 UserBox05 Dnogéfosm—
[+
] ga 006 UserBox06 [Scan]
éa 007 UserBox07

Documents Preferences

Login

Le document contenant les pages copiées est créé dans le répertoire ou le dossier sélectionné.
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H Suppression de pages dans un document
Vous pouvez supprimer les pages d'un document.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant le
document dont vous souhaitez supprimer des pages.

| (@ Electronic Filing |

Document & e-Filing (& items)

@ e-Filina

ol [ Public Box

ga 001 UserBox01
47 002 UserBox02 8
57003 UserBox03
&) 004 UserBox04
G 005 UserBox05
&) 006 UserBox06
i#l &7 007 UserBox07 [Ipublic Box [Joo1 usergoxo1

2 Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion estimpossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

3 Dans le volet Document, sélectionnez le document dans lequel vous souhaitez supprimer des
pages, puis cliquez sur [Modifier (Edit)].

|@Efecrmnfc Filing Login

Document [ DOC160510-001 (1/3) Status : View Edit

g e-Filing k z

[7 Public Box
= % 001 UserBox01 —
] Folder01
sessnnee

E DOC160510 [ ]

|2 DOC160510-00 4 ] I
47 002 UserBox0 | =
£ £ 003 UserBox0 1 / -
&7 004 UserBox04 EEEEEE
&7 005 UserBox05
&F 006 UserBox06
&p) 007 UserBox07 [Jrages 1 [Jrages 2 [pages 3

Les pages du document apparaissent dans le volet Contenu et le document passe du mode d'affichage au mode
d'édition.

Remarque

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant
donné qu'un autre utilisateur travaille actuellement sur ce document.
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4 Cochez les pages que vous souhaitez supprimer, puis sélectionnez [Modifier (Edit)] > [Supprimer

(Delete)].

|®Eisctmnfc Filing Login
Document t Status : Editing
4B e-Filing

[g) Public Box
=] éﬁ 001 UserBox01
(-] Folder0o1l
% DOC160510
DOC160510-00
&5 002 UserBox02
= 4 003 UserBox03
&7 004 UserBox04
&F 005 UserBox05 [prages 1
&p) 006 UserBox06

571 007 UserBoxD7 L%'

Pages 2 Pages 3

La boite de dialogue de confirmation apparait.

5 Cliquez sur [OK].

This site says...

Do you want to delete the page(s)?

A\

Les pages sélectionnées sont supprimées.

6 Cliquez sur [Enregistrer (Save)].

|®Eiectmnfc Filing Legin

Document [ DOC160510-001 (1/1) Status : Editing

g e-Filing —
[f) Public Box

= % 001 UserBox01 -

] Foldero1 4

& DOC160510 \)1 =
DOC160510-00 /

&p) 002 UserBox02

£ & 003 UserBox03

&g 004 UserBox04

&g 005 UserBox05 [Iprages 1

& 006 UserBox06

& 007 UserBox07 2 items are deleted.

La fenétre d'enregistrement du document apparait.

7 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

Save

Document NameG)OCWOST 0-001

¢ Sivous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son
nom, le document sera écrasé.

* Le document passe du mode d'édition au mode d'affichage.

Remarque

Ne fermez pas la fenétre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de
provoquer un dysfonctionnement du systeme. Si vous fermez la fenétre en cliquant sur [X] par erreur, mettez le
systéme hors tension avant de le remettre sous tension.
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M Insertion d'une page vierge dans un document
Vous pouvez insérer des pages vierges dans un document et sélectionner un format différent pour chacune d'elles.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant le
document dans lequel vous souhaitez insérer une page blanche.

| (¢ Electronic Filing |

Document & e-Filing (8 items)
{B.e-Filing
=l [ Public Box
ga 001 UserBox01
& 002 UserBox02 @ <
5 002 UserBox03
&g 004 UserBox04
ﬁﬁ 005 UserBox05
gﬁ 006 UserBox06
£l &y 007 UserBox07 [Ipublic Box [Joo1 usergoxo1

2 Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion estimpossible, contactez votre administrateur.

Conseil
Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

3 Dans le volet Document, sélectionnez le document dans lequel vous souhaitez insérer une page
blanche, puis cliquez sur [Modifier (Edit)].

|@Efectmnfc Fiting Login

Document [ DOC160510-002 (1/3) Status : View Edit

B e-Filing k
[ Public Box z
=] % 001 UserBox01 —

(-] Foldero1
E DOC160510 B [ ]
| DOC160510-00 4||

57002 UserBoxﬂk | J =k

5 003 Useroxod b / -
&7 004 UserBox04 EEEEEE
&7 005 UserBox05
&) 006 UserBox06
&) 007 UserBox07 [Jrages 1 [rages 2 [Ipages 3

Les pages du document apparaissent dans le volet Contenu et le document passe du mode d'affichage au mode
d'édition.

Remarque

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant
donné qu'un autre utilisateur travaille actuellement sur ce document.
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4 Cliquez sur l'espace entre les pages ou vous souhaitez insérer une page vierge.

|®Eisctmnfc Filing Login

Document | DOC160510-002 (1/3) Status : Editing

4B e-Filing —
[g) Public Box
=] éﬁ 001 UserBox01 -

# [ Foldero1 4|] |
| Doc160510 =
DOC160510-00

&5 002 UserBox02
&5 003 UserBox03
&7 004 UserBox04
&F 005 UserBox05 [Jrages 1 u [prages 2 [Jpages 3
&p) 006 UserBox06
&p) 007 UserBox07

8000000

Les indicateurs de direction se déplacent alors vers |'espace sur lequel vous avez cliqué.

5 Sélectionnez [Mise en page (Layout)] > [Insérer une page vierge (Insert Blank Page)].

|®Eiectmnfc Filing

Document

g e-Filing
[f) Public Box
= % 001 UserBox01
] Folder01
E DOC160510
DOC160510-00
&p) 002 UserBox02
&p) 003 UserBox03
&g 004 UserBox04
&g 005 UserBox05 [Iprages 1 [Iprages 2 [Ipages 3
& 006 UserBox06
& 007 UserBox07

Login

Status : Editing

La fenétre Insérer une page vierge apparait.

6 Sélectionnez le format de papier et 'orientation de la page vierge insérée et cliquez sur [OK].

Insert Blank Page
Select the paper size for the blank sheet o insert.

O Letter (2.5 x 11 in) ® Portrait
) Legal (8.5 x 14in) O Landscape,
Ad (210 x 297 mm)
Statement (5.5 x 8.5in)
A3 (297 x 420 mm)
B4 (257 x 364 mm)
B5 (182 x 257 mm)
Ledger (11 x 17 in)
Computer (10 1/8 x 14 in)
Folio (210 x 330 mm)
A5 (148 210 mm)
AB (105 % 148 mm)
13°LG (85x 13 i)
8.5"SQ (8.5x 8.5 in)
() BK (270 x 390 mm)
(16K (270 x 195 mm)

A\

Une page vierge est insérée entre les pages spécifiées.

Conseil

Sa taille différe selon le modéle.
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7 Cliquez sur [Enregistrer (Save)].

Electronic Filing

L '

Document
{fj e-Filing
[°g) Public Box
=] % 001 Usero1
] Folder01

&) 002 User02
&) 003 User03
Gl 004 User04
ga 005 User05
&) 006 User06
&) 007 User07

& DOC160510
DOC160510-(

| DOC160510-001 (2/4)

Documents Preferences Login

Status : Editing

[Orages 1

[Orages 2

[Irages 3

[Jrages 4

La fenétre d'enregistrement du document apparait.

8 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

Save

Document Name|| [DOC160510-001

* Sivous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son

nom, le document sera écrasé.

¢ Le document passe du mode d'édition au mode d'affichage.

Remarque

Ne fermez pas la fenétre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de
provoquer un dysfonctionnement du systéme. Si vous fermez la fenétre en cliquant sur [X] par erreur, mettez le
systéme hors tension avant de le remettre sous tension.
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B Déplacement de pages dans un document
Vous pouvez modifier l'organisation des pages dans un document.

1 Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant le
document dont vous souhaitez réorganiser des pages.

| (@ Electronic Filing |

Document & e-Filing (& items)

@ e-Filina

ol [ Public Box

ga 001 UserBox01
47 002 UserBox02 8
57003 UserBox03
&) 004 UserBox04
G 005 UserBox05
&) 006 UserBox06
i#l &7 007 UserBox07 [Ipublic Box [Joo1 usergoxo1

2 Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil
Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

3 Dans le volet Document, sélectionnez le document dans lequel vous souhaitez déplacer des
pages, puis cliquez sur [Modifier (Edit)].

| ¢ Efectronic Filing Login

& DOC051016 (1/3) Status : View i
Document & Edit
{83 e-Filing %
[l Public Box 2
B % 001 UserBox01 —

(=] Foldero1
E DOC160510 B [ ]
£l £ 002 UserBox02 4 1 l
() Folder02 1 J -
|2 DOC051016 / =
&r 003 UserBoxﬂk EEEEEE
& 004 UserBox0 N .
&l 005 UserBox05
&l 006 UserBox06 [Cpages 1 [pages 2 [pages 3
gyl 007 UserBox07

Les pages du document apparaissent dans le volet Contenu et le document passe du mode d'affichage au mode
d'édition.

Remarque

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant
donné qu'un autre utilisateur travaille actuellement sur ce document.
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4 Cochez les pages que vous souhaitez déplacer, puis sélectionnez [Modifier (Edit)] > [Couper
(Cut)].

(¢ Electronic Filing

Documents Preferences

Loqgin

Status : Editing

Document

4B e-Filing
[g) Public Box
=] éﬁ 001 UserBox01
(-] Folder0o1l

% DOCO051016-00
DOC160510

&g 002 UserBox02

&5 003 UserBox03

&7 004 UserBox04

&F 005 UserBox05

&p) 006 UserBox06

&p) 007 UserBox07

Pages 1

O Pages 2 O Pages 3

Les pages sélectionnées sont copiées dans le presse-papier et supprimées du document.

Remarque

Si l'utilitaire Web e-Filing est en train d'effectuer une tache, attendez qu'il ait fini.

5 Cliquez sur l'espace entre les pages ol vous souhaitez insérer les pages copiées.

|®Electmnfc Filing Login

Document i DOC160510 (12) Status : Editing

B e-Filing
(7 Public Box
El éﬁ 001 UserBox01
=] Foldero1 =

[& DOCO051016- [%
DOC160510 I -

&p 002 UserBox02 EEEEEE E

&p 003 UserBox03

&p) 004 UserBox04

571 005 UserBox05 [Jpages 1 [prages 2 N ‘

&p 006 UserBox06

&p 007 UserBox07 1 item is cut.

=]
=1

Les indicateurs de direction se déplacent alors vers |'espace sur lequel vous avez cliqué.

6 Sélectionnez [Modifier (Edit)] > [Coller (Paste)].

| (¢ Electronic Filing TeTT—

Document Status : Editing

e-Filing
Fili
[f Public Box
=] % 001 UserBox01
(] Foldero1
% DOC051016-
DOC160510
&g 002 UserBox02
&g 003 UserBox03
&l 004 UserBox04
&l 005 UserBox05 [Cpages 1 Opages 2
&g 006 UserBox06
&g 007 UserBox07

=]

0

Les pages copiées sont insérées entre les pages spécifiées.

7 Poursuivez la procédure décrite aux étapes 4 a 6 pour réorganiser les pages.
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8 Une fois la réorganisation terminée, cliquez sur [Enregistrer (Save)].

|®Etecrmnfc Filing Login

Document | DOC160510 (3/3) Status : Editing
4B e-Filing

[g) Public Box
=] éﬁ 001 UserBox01
(-] Folder0o1l

% DOCO051016-00

DOC160510 -
&f) 002 UserBox02 EEEEEN
&5 003 UserBox03
&7 004 UserBox04
&F 005 UserBox05 [prages 1 [prages 2 [rages 3
&p) 006 UserBox06
&p) 007 UserBox07 1 item is pasted.

8000004

Iy

La fenétre d'enregistrement du document apparait.

9 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

Save

Document Name ‘DOC15051 0

* Sivous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son
nom, le document sera écrasé.

¢ Le document passe du mode d'édition au mode d'affichage.

Remarque

Ne fermez pas la fenétre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de
provoquer un dysfonctionnement du systeme. Si vous fermez la fenétre en cliquant sur [X] par erreur, mettez le
systéeme hors tension avant de le remettre sous tension.
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Déplacement et fusion de documents

Vous pouvez non seulement déplacer des documents entre les répertoires et les dossiers, mais également combiner
plusieurs documents en un seul.

P.93 "Déplacement de documents"

P.95 "Fusion de documents"

M Déplacement de documents

Vous pouvez déplacer des documents d'une boite ou d'un dossier a un(e) autre, par exemple afin de simplifier la
gestion des documents.

1

Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant le
document que vous souhaitez déplacer.

| (@ Electronic Filing |

Document & e-Filing (8 items)
a-Filina

=l (- Public Box
i) 001 UserBox01
i1 002 UserBox02 Ga
&7 003 UserBox03
& 004 UserBox04
¢ 005 UserBox05

&p) 006 UserBox06
[ 57 007 UserBox07

OPublic Box oot userBoxo1

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un acces non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

Cochez les documents que vous souhaitez déplacer, puis sélectionnez [Modifier (Edit)] > [Couper
(Cut)].

| (¢ Electronic Filing

Document
4B e-Filing
[g Public Box
=] éﬁ 001 UserBox01
(-] Folder0o1l
% DOCO051016-00
% DOC160510
&5 002 UserBox02
&5 003 UserBox03
&7 004 UserBox04

Documents Preferences

Login

&F 005 UserBox05
&p) 006 UserBox06
&p) 007 UserBox07

A

[IFoldero1

DOCD51016-

[Ipocieosio
[Scan]

Les documents sélectionnés sont copiés dans le presse-papiers et supprimés de la boite ou du dossier en cours.

Remarque

Si l'utilitaire Web e-Filing est en train d'effectuer une tache, attendez qu'il ait fini.
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4 Dans le volet Document, sélectionnez la boite ou le dossier dans lequel vous souhaitez coller les
documents.

§ Electronic Filing Login

=] éﬁ 001 UserBox01 S
[0) Folder01 essssses
[ Doc160510
57 002 Usersox02 D 4” [ |
571 003 UserBox03 f ’
57 004 UserBox04 :
Eﬁ 005 UserBox05
Eﬁ 006 UserBox06 s
57 007 UserBox07 [IFoldero1

[Ipocieosio
[Scan]

1itam ic cut

5 Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un accés non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

6 Sélectionnez [Modifier (Edit)] > [Coller (Paste)].

| (@ Electronic Filing

Document
B e-Filing
(7 Public Box
El éﬁ 001 UserBox01
=] Foldero1
[ DOC160510
£ 4§ 002 UserBox02
(-] Folder02
éﬁ 003 UserBox03
&p) 004 UserBox04
&g 005 UserBox05
571 006 UserBox06 OFelderoz
&p 007 UserBox07

Documents Preferences

Login

Les documents sont créés dans le répertoire ou le dossier sélectionné(e).
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B Fusion de documents

Vous pouvez copier toutes les pages d'un document et les insérer dans un autre.
Le document que vous souhaitez insérer est appelé document source. Le document dans lequel vous souhaitez

intégrer le document source est le document cible.

1

Dans le volet Document de l'onglet [Documents], sélectionnez la boite ou le dossier contenant les
documents source.

| (¢ Electronic Filing |

Document
@ e-Filinn

=l 77 Public Box
ga 001 UserBox01
&p 002 UserBox02
&) 003 UserBox03
&7 004 UserBox04
&) 005 UserBox05
&) 006 UserBox06
i1 57 007 UserBox07

& e-Filing (8 items)

7]

Cpublic Box

[oo1 userBoxo1

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Sivous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un accés non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion estimpossible, contactez votre administrateur.

Conseil

Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

Cochez les documents sources, puis sélectionnez [Modifier (Edit)] > [Copier (Copy)].

Electronic Filing

L |

Document

g e-Filing
[7 Public Box
= % 001 UserBox01

] Folder01
E DOC160510

&pl 002 UserBox02
&g 003 UserBox03
&g 004 UserBox04
&7 005 UserBox05
&7 006 UserBox06
&F) 007 UserBox07

CIFoldero1

[Mpocieos1o
[Scan]

Documents Preferences Login

[ |
M |

Les documents sélectionnés sont copiés dans le presse-papiers.

Remarque

Si l'utilitaire Web e-Filing est en train d'effectuer une tache, attendez qu'il ait fini.
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5

Dans le volet Document, sélectionnez la boite ou le dossier contenant le document de
destination.

| (¢ Electronic Filing

Document 4 UserBox01 (2 items)
{FeFiling
[g Public Box
=] éﬁ 001 UserBox01
(-] Folder0o1l
% DOC160510
7 002 UserBox02 D
&5 003 UserBox03
&g 004 UserBox04
&F 005 UserBox05
&F 006 UserBox06
&p) 007 UserBox07

Documents Preferences Login

[IFoldero1

Fpociensio
[Scan]

Si vous avez sélectionné une boite protégée par un mot de passe, la fenétre d'authentification
par mot de passe apparait. Saisissez le mot de passe et cliquez sur [OK].

Remarque

Si vous entrez plusieurs fois un mot de passe incorrect pour ouvrir le répertoire, vous ne pourrez pas vous
connecter pendant une certaine période car cela sera considéré comme un accés non autorisé. Lorsque "La boite
est verrouillée." s'affiche et que la connexion est impossible, contactez votre administrateur.

Conseil
Vous pouvez également saisir le mot de passe d'un utilisateur disposant des droits d'administration dans [Mot de
passe de la boite (Box Password)].

Dans le volet Document, sélectionnez le document de destination, puis cliquez sur [Modifier
(Edit)].

| (@ Electronic Filing

Documents Preferences Login

El éﬁ 001 UserBox01
=] Foldero1
[ DOC160510
£ 4 002 UserBox02
(-] Folder02
% DOC051016
&g 003 UserBoxO0f
&g 004 UserBox0'
&p 005 UserBox05
&p 006 UserBox06
&p) 007 UserBox07

=, DOC051016 (1/3 Status : View
Document & (3
B e-Filing k

(7 Public Box 2

O Pages 1

DPages 2

O Pages 3

Les pages du document apparaissent dans le volet Contenu et le document passe du mode d'affichage au mode

d'édition.

Remarque

Si l'état du document indique "En cours d'utilisation", vous ne pouvez pas passer en mode modification étant
donné qu'un autre utilisateur travaille actuellement sur ce document.
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7 Cliquez sur l'espace entre les pages ol vous souhaitez fusionner les documents.

|®Eisctmnfc Filing Login

Document /& DOC051016 (1/3) Status : Editing

4B e-Filing —
[g) Public Box
=] éﬁ 001 UserBox01
[ Foldero1 4r| B
& Doc160510 j ‘
= & 002 UserBox02
(~) Folder02
DOCO051016
&F 003 UserBox03
&7 004 UserBox04 [prages 1 [prages 2 [rages 3 \ ‘
&g 005 UserBox05
&p) 006 UserBox06
&p 007 UserBox07

8000000

Les indicateurs de direction se déplacent alors vers |'espace sur lequel vous avez cliqué.

8 Sélectionnez [Modifier (Edit)] > [Coller (Paste)].

| (@ Electronic Filing

Document

g e-Filing
[f) Public Box
= % 001 UserBox01
] Folder01
% DOC160510
£ 4 002 UserBox02
[£] Folder0o2
DOCD51016
&g 003 UserBox03
&g 004 UserBox04 [Iprages 1 [Iprages 2 [Ipages 3
& 005 UserBox05
& 006 UserBox06
&g 007 UserBox07

Documents Preferences

Login

Status : Editing

Les documents copiés sont fusionnés entre les pages spécifiés.

9 Cliquez sur [Enregistrer (Save)].

|®Eisctmnfc Filing Login

& DOC051016 (4/5 Status : Editin
Document = 9
:@ e-Filing pr— B
[g) Public Box csssssss
B &g 001 UserBox01 o [ ]
] Foldero1 ] |

/& DOC160510 jﬂ

= £ 002 UserBox02
(-] Felder02

DOC051016
&p) 003 UserBox03
&p) 004 UserBox04 [Jrages 1 [pages 2 [Ipages 3 Cpages 4
&5 005 UserBox05 —
&0 006 UserBox06
&F 007 UserBox07

|:|Pages 5

La fenétre d'enregistrement du document apparait.
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10 Saisissez le nom du document, puis cliquez sur [Enregistrer (Save)].

Save

Document Name ‘DOCD51OTG

¢ Sivous renommez le document, il sera enregistré en tant que nouveau document. Si vous ne modifiez pas son
nom, le document sera écrasé.

* Le document passe du mode d'édition au mode d'affichage.

Remarque

Ne fermez pas la fenétre d'enregistrement du document en cliquant sur le bouton [X] car cela risque de
provoquer un dysfonctionnement du systeme. Si vous fermez la fenétre en cliquant sur [X] par erreur, mettez le

systéme hors tension avant de le remettre sous tension.

98 Déplacement et fusion de documents



ADMINISTRATION SYSTEME DE L'e-FILING

Cette section est destinée aux administrateurs des systémes. Les utilisateurs généraux n'ont pas besoin de la lire.
Elle décrit la fonction administration systeme de 'e-Filing.

Administration systeme.........ccceuuuunee. eeeeereeernreesssseenes eeeeeerernnneesseenenes eeerereeenenanannnens ... 100
Connexion en tant qu'admMiNiStrateUr SYSTEME........cceiririerereiririee ettt eesess e tesese s s sesessssesesesessesesasnanns 100
A propos de I'6Cran admMiNISEFATEUL ......c.c.eveueveeieeereree ettt ettt s e st es st etessses st etensnsesesesesenes 101

Gestion du périphérique de stockage interne dans €-FiliNg.......cccceeeviririeeecinenseeeee e 102




Administration systéme

Cette section décrit ['administration systeme des fonctions e-Filing.
P.100 "Connexion en tant qu'administrateur systéme"

P.101 "A propos de |'écran administrateur"

P.102 "Gestion du périphérique de stockage interne dans e-Filing."

H Connexion en tant qu'administrateur systeme

Pour vous connecter en tant qu'administrateur systeme, lancez |'utilitaire Web e-Filing et suivez la procédure ci-
dessous.

Remarque

"Administrateur systéme" et "Utilisateur disposant des droits d'administration" sont définis comme suit dans ce
manuel.

» Administrateur systéeme::
Utilisateur avec le réle d'administrateur

* Utilisateur disposant des droits d'administration
Utilisateur dont |'ID est "Admin"

1 Cliquez sur le lien Connexion situé dans l'angle supérieur droit de la page.

Documents Preferences Login

La page Connexion administrateur s'ouvre.

2 Saisissez le mot de passe de l'administrateur, puis cliquez sur [Connexion (Login)].

| (¥ Electronic Filing |

Administrator Login
\

L'onglet [Administration] apparait dans les onglets principaux.

Remarque

Sivous entrez plusieurs fois un mot de passe d'authentification incorrect pour vous connecter a ['utilitaire
Web e-Filing en mode administrateur, vous ne pourrez pas vous connecter pendant un certain temps car cela
sera considéré comme un accés non autorisé.

Pour empécher son accés non autorisé par d'autres utilisateurs, cliquez sur le lien de déconnexion et assurez-

vous de fermer votre navigateur lorsque vous vous déconnectez de ['utilitaire Web e-Filing en mode
administrateur.

Conseil

Le mot de passe de |'administrateur est identique a celui défini dans TopAccess ou sur ['écran tactile. Par défaut,
le mot de passe de l'administrateur est "123456".
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B A propos de l'écran administrateur

L'onglet [Administration] permet a ['administrateur systéme de gérer les données e-Filing. Il est visible uniquement
lorsque vous vous connectez en tant qu'administrateur systeme.
P.101 "Page [Gestion de la boite (Box Management)]"

Conseil

L'administrateur peut également paramétrer les notifications pour e-Filing a 'aide de TopAccess en mode
administrateur. Pour plus d'informations sur le paramétrage des notifications pour e-Filing, reportez-vous au Guide
de TopAccess.

U Page [Gestion de la boite (Box Management)]

Cette page permet de supprimer manuellement les zones utilisateur inutiles ou corrompues. Utilisez cette option
pour restaurer |'espace disponible du périphérique de stockage interne. Vous pouvez également débloquer les
répertoires utilisateurs verrouillés suite a la saisie de mots de passe erronés.

@ Electronic Filing [ L T Logout
Box Management
1 w—-Filing Disk Space Available : 10230 MB
I Stored Data [ Data Type [ Data Size [ Remarks |
I Box | Shared File | 9656 KE | |
4 —
3 1
[ Delete || Unlock
2 — 4 a Box Number Box Name Used capacity Status
O 001 UserBox01 6313 KB
m] 002 UserBox02 3308 KB
m] 003 UserBox03 5KB
m] 004 UserBox04 5KB
O 005 UserBox05 5KB
m] 006 UserBox06 5KB
m] 007 UserBox07 5KB

1. Espace disque disponible
Cette zone indique |'espace disponible du périphérique de stockage interne pour le stockage des données dans
e-Filing.

2. Nc°de laboite /Nom de la boite / Capacité utilisée / Etat
Cette option permet d'afficher la liste de tous les répertoires utilisateur. Lorsque vous cliquez sur le lien du
numéro ou du nom du répertoire, la fenétre des propriétés du répertoire s'ouvre et indique les propriétés
détaillées du répertoire. L'état d'une zone utilisateur verrouillée s'affiche dans les résultats.
Pour supprimer ou déverrouiller un répertoire utilisateur, cochez la case a gauche de chaque propriété, puis
cliquez sur [Supprimer (Delete)] ou [Déverrouiller (Unlock)].

3. [Supprimer (Delete)]
Cliquez sur ce bouton pour supprimer les répertoires sélectionnés. Au préalable, cochez les cases des zones
utilisateur que vous souhaitez supprimer.

Conseil

* |l estimpossible de supprimer un répertoire public.
* Pour plus d'informations sur 'effacement des répertoires utilisateur, reportez-vous a la section suivante :
P.102 "Effacement des données dans les répertoires"

4. [Déverrouiller (Unlock)]
Cliquez sur ce bouton pour déverrouiller les répertoires sélectionnés. Au préalable, cochez les cases des zones
utilisateur que vous souhaitez déverrouiller.

Conseil

Pour plus d'informations sur le déverrouillage des répertoires utilisateur, reportez-vous a la section suivante :
P.103 "Déverrouillage des répertoires utilisateur"
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M Gestion du périphérique de stockage interne dans e-Filing.

Un administrateur doit régulierement contrdler les données stockées dans les dossiers e-Filing afin de garantir un
espace du périphérique de stockage interne suffisant pour les opérations quotidiennes.

Les administrateurs peuvent gérer les boites, dossiers et documents de la méme maniere que les utilisateurs
généraux. Pour plus de détails sur cette opération, reportez-vous a la section ci-dessous.

P.40 "Gestion des répertoires et des dossiers utilisateur"

P.50 "Gestion de documents"

Cette section décrit la fonction d'administrateur qui vous permet de supprimer les répertoires et la méthode de
déverrouillage des répertoires utilisateur verrouillés a la suite de saisies incorrectes du mot de passe.

P.102 "Effacement des données dans les répertoires"

P.103 "Déverrouillage des répertoires utilisateur"

Q Effacement des données dans les répertoires

Vous pouvez effacer manuellement les champs contenus dans e-Filing dont les données ont été altérées (suite a une
défaillance du périphérique de stockage interne, par exemple) et qui sont devenus inutilisables.

1 Connectez-vous a la page Administrateur.
P.100 "Connexion en tant qu'administrateur systéeme"
La page Gestion des dossiers apparait.

Remarque

* Avant de supprimer les répertoires, il est recommandé d'archiver les documents qui y sont contenus. Une fois
les répertoires supprimés, vous ne pouvez plus restaurer les documents.
P.62 "Archivage de documents"

* L'utilitaire de sauvegarde/restauration inclus dans le DVD Utilitaires client/Documentation utilisateur vous
permet de sauvegarder les données contenues dans les boites.

Conseil

Vous pouvez afficher la fenétre des propriétés du répertoire en cliquant sur le lien du numéro ou du nom du
répertoire.

2 Cochez les cases des répertoires utilisateur a supprimer et cliquez sur [Supprimer (Delete)].

@ Electronic Filing Documents  Preferences | Administration I E-:T-0113

Box Management
e-Filing Disk Space Available : 10211 MB

Stored Data [ Data Type [ Data Size | Remarks |
| Box | Shared File | 28 MB | |
Unlock

'~ Box Number Box Name Used capacity Status
\} L, )

001 UserBox01 6278 KB

002 UserBox02 3603 KB

003 UserBox03 5KB

004 UserBox04 7982 KB

005 UserBox05 10 MB

006 UserBox06 5KB

007 UserBox07 5KB

Top| Help

La boite de dialogue de confirmation apparait.

Conseil

Pour plus d'informations sur la page Gestion de la boite, reportez-vous a la section suivante :
P.101 "Page [Gestion de la boite (Box Management)]"
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3 Cliquez sur [OK].

This site says...

Do you want to delete the item(s)?

A

\]

Les répertoires utilisateur sélectionnés sont supprimés de e-Filing.

QO Déverrouillage des répertoires utilisateur

Lorsque le parametre Verrouillage de e-Filing est défini sur “Activer” dans la police de mot de passe, si un mot de
passe erroné est saisi consécutivement un nombre de fois spécifié, le répertoire utilisateur est verrouillé et ne peut
pas étre utilisé pendant un certain temps. L'administrateur du systéme a la possibilité de déverrouiller les répertoires
utilisateur qui ont été ainsi verrouillés.

Remarque

La police de mot de passe peut étre définie dans TopAccess. Pour plus d'informations sur la police de mot de passe,
reportez-vous au Guide de TopAccess.

1 Connectez-vous a la page Administrateur.

P.100 "Connexion en tant qu'administrateur systéme"
La page Gestion des dossiers apparait.

Conseil

* Pour les répertoires utilisateur verrouillés, le champ Etat affiche “Verrouillé”.

* Vous pouvez afficher la fenétre des propriétés du répertoire en cliquant sur le lien du numéro ou du nom du
répertoire.

2 Cochez la case du répertoire utilisateur a déverrouiller, puis cliquez sur [Déverrouiller (Unlock)].

(@ Electronic Filing

Box Management
e-Filing Disk Space Available - 10211 MB

Documents

Preferences

Administration

Logout

Stored Data [

Data Type

Data Size

Remarks

Box

Shared File

28 MB

Unlock

Box Name

Used i

O

UserBox01

6278 KB

UserBox02

3603 KB

UserBox03

5KB

UserBox04

7982 KB

UserBox05

10 MB

UserBox06

5KB

UserBox07

5KB

() ] ] JES] ) ) 3

Top | Help

Le verrouillage du répertoire utilisateur sélectionné est supprimé.

Conseil

Pour plus d'informations sur la page Gestion de la boite, reportez-vous a la section suivante :

P.101 "Page [Gestion de la boite (Box Management)]"
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